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Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the 
trade laws of other countries. You agree to comply with all export control regulations and to obtain any required 
licenses or classification to export, re-export, or import deliverables. You agree not to export or re-export to entities 
on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export 
laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. 
Please refer to Novell!s International Trade Services (http://www.novell.com/info/exports/) for more information on 
exporting Novell software. Novell assumes no responsibility for your failure to obtain any necessary export 
approvals.

Copyright © 2005-2007 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, 
stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed at Novell!s Legal Patents (http://www.novell.com/company/legal/patents/) and one or more additional 
patents or pending patent applications in the U.S. and in other countries.

Novell, Inc.

404 Wyman Street, Suite 500
Waltham, MA 02451

U.S.A.

www.novell.com

Online Documentation: To access the online documentation for this and other Novell products, and to get 
updates, see Novell Documentation (http://www.novell.com/documentation).
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Novell Trademarks

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/company/legal/
trademarks/tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.
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About This Guide

This Novell® GroupWise® 7.0 WebAccess Client User Guide explains how to use the GroupWise 
WebAccess client. The guide is divided into the following sections:

! Getting Started

! Using Your GroupWise WebAccess Mailbox

! Working with Items in Your Mailbox

! Scheduling Group and Posted Items

! Using Your Calendar

! Using the Address Book

! Customizing Your GroupWise WebAccess Client

! GroupWise Frequently Asked Questions

! Documentation Updates

Audience

This guide is intended for GroupWise users.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of the GroupWise 7.0 WebAccess Client User Guide, visit the Novell 
GroupWise 7.0 documentation Web site (http://www.novell.com/documentation/gw7).

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 7.0 
documentation Web site (http://www.novell.com/documentation/gw7):

! Installation Guide

! Administration Guide

! Multi-System Administration Guide 

! Interpretability Guide

! Troubleshooting Guide

! GroupWise Windows Client User Guide

! GroupWise Cross-Platform User Guide

! GroupWise Client Frequently Asked Questions (FAQ)
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Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux* or UNIX*, should use forward slashes as required by your software.
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1Getting Started

This section of the GroupWise® WebAccess User Guide contains the following topics:

! Section 1.1, "Starting GroupWise WebAccess,# on page11

! Section 1.2, "Understanding Timing Out from GroupWise WebAccess,# on page 12

! Section 1.3, "Understanding the GroupWise WebAccess Main Window,# on page 12

! Section 1.4, "Understanding Your Mailbox,# on page 17

! Section 1.5, "Learning More,# on page 17

1.1  Starting GroupWise WebAccess
You start GroupWise WebAccess as you would any other home page on the Internet. Use your Web 
browser to go to the URL your administrator gives you, such as http://server/gw/webacc, or an IP 
address such as 155.155.11.22. 

Figure 1-1   WebAccess Login Page

To log in to WebAccess:

1 On the WebAccess login page, enter your username and password.

2 Select the language you!d like to use from the Language drop-down menu.

3 Select your connection speed:

! High (Broadband), which has all the features that are available in GroupWise WebAccess. 
Use this default setting if you have a high-speed internet connection.

! Low (Dial-up), which looks the same as the default high-speed interface but does not 
autoupdate your message list and calendar. It also does not support name completion.

4 (Conditional) If you!re using a mobile device, select Use the Basic Interface.

The basic interface has limited functionality and graphics. It is designed to perform the most 
basic tasks in GroupWise.

5 (Optional) If you use the same browser to log in to GroupWise WebAccess every time, select 
Remember My Settings to save your preferences.
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6 Click Login.

Your GroupWise WebAccess mailbox opens.

1.2  Understanding Timing Out from GroupWise 
WebAccess
Specific actions, such as opening or sending an item, generate a call to the Web server. Other 
actions, such as scrolling through items in the Item List, composing a message without sending it, or 
reading Help topics, do not generate a call to the Web server. If, for a period of time, you leave 
GroupWise WebAccess alone or perform actions that do not generate a call, WebAccess logs you 
out. Doing so not only provides security for your e-mail but also ensures that the Web server and 
GroupWise WebAccess run efficiently.

The timeout period is determined by your GroupWise system administrator. If you try to perform an 
action after you have been logged out, you are prompted to log in again.

NOTE: You must authenticate correctly to be returned to your work after a timeout. If you haven!t 
logged in correctly, the message you were composing might appear to be lost. Use the keyboard to 
return to your saved message window (for example, Alt + Left-arrow key in Windows*).

1.3  Understanding the GroupWise WebAccess 
Main Window
When you open GroupWise WebAccess, you see the Main Window, shown below. This is your main 
work area in GroupWise. From the Main Window, you can read your messages, schedule 
appointments, view your Calendar, manage contacts, and much more.

Figure 1-2   Main Window

The Main Window has different components to help you accomplish your daily tasks. The following 
sections describe the various components you can use from the Main Window:

! Section 1.3.1, "Nav Bar,# on page 13
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! Section 1.3.2, "Toolbar,# on page 14

! Section 1.3.3, "Folder List,# on page 14

! Section 1.3.4, "Item List,# on page 16

1.3.1  Nav Bar 

Figure 1-3   The GroupWise Nav Bar

The Nav Bar provides for quick access to your most commonly used folders. It contains the 
Mailbox, Calendar, Documents, and other folders.
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1.3.2  Toolbar

Figure 1-4   The GroupWise Toolbar

The toolbar lets you quickly accomplish common GroupWise tasks, such as opening the Address 
Book, sending mail messages, and managing folders.

1.3.3  Folder List

The Folder List displays the folders used to organize the items you send and receive. You can add 
additional folders to further help you organize your items. The Mailbox folder is the default folder 
that is opened when you first log in.

The following folders are displayed in the Folder List. You can open a folder by clicking the icon.

Icon Description

Home Represents your GroupWise database. All folders in you Main Window are 
subfolders of your home user folder.

 Mailbox Lists all items you receive, with the exception of scheduled items 
(appointments, tasks, and reminder notes) that you have accepted or declined. 
Accepted scheduled items and tasks are moved to the Calendar. The Mailbox 
is a system folder. 

 Unopened Items Lists received items you have not yet opened. Unopened Items is a system 
folder.

 Sent Items Lists items you send from the Mailbox and Calendar. Sent Items is a system 
folder. After you move a sent item from the Sent Items folder to another folder, it 
no longer displays in the Sent Items folder. (In the previous version of 
GroupWise WebAccess, the Sent Items folder was a query folder that listed 
sent items from all folders.) 
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System Folders

The folders listed in the table are system folders, which are created by GroupWise and cannot be 
deleted or renamed.

For additional information about using folders, see Section 2.5, "Using the Folder List,# on page 28.

Personal Folders

You can add additional folders to organize your items. For example, you could add a folder to your 
Cabinet to store all messages you receive regarding a specific project you are working on.

Shared Folders

You can share personal folders with other users. Recipients of the shared folder receive a 
notification explaining that you have shared the folder with them. They can then accept the folder or 
decline the folder.

Find Results Folders

In the Windows version of GroupWise, you can save the results of an item or document search in a 
folder. You cannot do this in GroupWise WebAccess. However, GroupWise WebAccess lets you 
view any Find Results folders you create in another version of GroupWise.

 Calendar Lists all appointments, tasks, and notes in your Calendar. Calendar is a system 
folder. 

Task List

 Checklist Lists items you have moved to this folder. You can move any items (mail 
messages, phone messages, reminder notes, tasks, or appointments) to this 
folder and arrange them in the order you want. Each item is marked with a 
check box so that you can check items off as you complete them. Checklist is a 
system folder.

In the previous version of GroupWise WebAccess, a Task List folder listed all 
the task items in your Mailbox and Calendar. Task List was a query folder. For 
more information, see "Using the Checklist Folder# on page 32.

 Cabinet Lists personal folders you create. Cabinet is a system folder. 

 Work in Progress Lists items that have been saved to be sent later. Work in Progress is a system 
folder.

 Junk Mail Lists e-mail items from addresses and Internet domains that are junked through 
Junk Mail Handling are placed in the Junk Mail folder. This folder is not created 
in the folder list unless a Junk Mail option is enabled. Junk Mail is a system 
folder.

 Trash Lists all deleted mail and phone messages, appointments, tasks, documents, 
and reminder notes that have not yet been purged. Items in the Trash can be 
viewed, opened, or returned to your Mailbox before the Trash is emptied. 
(Emptying the Trash removes items in the Trash from the system.) Trash is a 
system folder. 

Icon Description
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1.3.4  Item List

The Item List displays the contents of the folder that is currently open. By default, the most recent 
20 items in the folder are displayed. If the folder contains more than 20 messages, a Display Next 
button appears at the bottom of the list. You can use it to display the next 20 messages, or you can 
choose to select more or less than 20 messages.

The icon next to each item indicates the item type, status, and priority. You click an item to open it. 
You can drag and drop items to move them. When you open an item, all actions you can perform on 
that item type are displayed at the top of the item view. For easy access, actions that you commonly 
perform on items are also displayed at the top of the Item List. You can select multiple items by 
clicking the boxes to the left of the items.

Whenever you select items in the Item List and perform an action on them, WebAccess updates the 
Item List. To refresh the list manually, open the folder again or click Update at the top of the list.

The following icons can be displayed in the Item List:

Icon Message Type, Status, and Priority

  Unopened mail message (high, normal, low priority)

  Opened mail message (high, normal, low priority)

  Appointments (high, normal, low priority)

  Tasks (high, normal, low priority)

  Unopened note (high, normal, low priority)

  Opened note (high, normal, low priority)

  Unopened phone message (high, normal, low priority)

  Opened phone message (high, normal, low priority)

  Reply requested (high, normal, low priority)

Unopened document reference

Opened document reference

One or more attachments included with the item

Shared folder notification

Shared address book notification

Sent item

Unopened posted item (shared folder)

Opened posted item (shared folder)

One or more attachments are included with the item.

Draft item.

Sent item.

Replied to item.
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1.4  Understanding Your Mailbox
Your received items are stored in your GroupWise Mailbox.

You can organize your messages by moving them into folders within your Cabinet, and you can 
create new folders as necessary.

1.4.1  Bolded Items in Your Mailbox

All unopened items in your Mailbox are bolded to help you easily identify which items and 
documents you have not yet read. The icon appearing next to an item also indicates if it is unopened.

1.5  Learning More
You can learn more about GroupWise from the following resources:

! Section 1.5.1, "GroupWise 7 Documentation Web Page,# on page 17

! Section 1.5.2, "GroupWise Cool Solutions Web Community,# on page 17

1.5.1  GroupWise 7 Documentation Web Page

For extensive GroupWise administration documentation, go to the GroupWise 7 area on the Novell 
Documentation (http://www.novell.com/documentation/lg/gw7/docui/index.html) Web site.

1.5.2  GroupWise Cool Solutions Web Community

At GroupWise Cool Solutions, you!ll find tips, tricks, feature articles, and answers to frequent 
questions. In the Main Window, click Help > Cool Solutions Web Community or go to http://
www.novell.com/coolsolutions/gwmag (http://www.novell.com/coolsolutions/gwmag).

Forwarded item.

Delegated item.

Replied to and forwarded item.

Replied to and delegated item.

Forwarded and delegated item.

Replied to, forwarded, and delegated item.

Icon Message Type, Status, and Priority
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2Using Your GroupWise 
WebAccess Mailbox

This section of the GroupWise® WebAccess User Guide provides basic information to get you 
started using GroupWise WebAccess.

! Section 2.1, "Composing Items,# on page 19

! Section 2.2, "Managing Items You Receive,# on page 23

! Section 2.3, "Managing Items You Send,# on page 26

! Section 2.4, "Printing from WebAccess,# on page 28

! Section 2.5, "Using the Folder List,# on page 28

! Section 2.6, "Working with Shared Folders,# on page 33

! Section 2.7, "Printing Items,# on page 36

! Section 2.8, "Using Proxy,# on page 36

! Section 2.9, "Saving Items in Your Mailbox,# on page40

! Section 2.10, "Opening and Emptying the Trash,# on page 40

2.1  Composing Items
GroupWise WebAccess has five different item types: mail message, phone message, appointment, 
note, and task. You address all item types in the same way, using the Address Book to add 
recipients! addresses to the To, CC, and BC boxes. You can also attach files to each item type and 
include Web site locations (URLs) in the Subject and Message box of each item type.

These five item types fit into three categories: unscheduled, scheduled, and posted items.

! Unscheduled Items: Unscheduled items include mail messages and phone messages. Both 
types of messages let you send a messages that are not scheduled for a particular time or date.

! Mail Message: Lets you specify a subject and message. 

! Phone Message: Similar to mail messages, except that phone messages have boxes for 
caller, company, and phone number information.

! Scheduled Items: Appointments, tasks, and notes are scheduled items, meaning that they 
appear in the recipient!s Calendar as well as the Mailbox. The recipient of an appointment, task, 
or note has the option of accepting or declining it. Accepted items are removed from the 
recipient!s Mailbox and stored in the recipient!s Calendar. Declined items are removed from 
both the recipient!s Mailbox and the Calendar. If you are the sender, you can see what action 
recipients have taken by checking the status information for the scheduled item.

! Appointment: Lets you include the time, date, and place of the appointment. You can use 
Busy Search to find times when all recipients are free. 

! Task:  Lets you indicate which day you want the task to appear in the recipient!s Calendar 
and which day you want the task completed. You can also assign a priority to the task. 
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! Note:  Lets you indicate which day you want the note to appear on the recipient!s 
Calendar. Because notes are posted in the recipient!s Calendar, they are frequently used as 
reminders of specific events, such as days off, project deadlines, or birthdays.

! Posted Items: Posted items are scheduled items you create for yourself. They function like 
other scheduled items, but are placed directly in your Calendar. 

For all items, GroupWise WebAccess uses the default font setting that is set in your browser. To 
change the font size of your incoming and outgoing messages, change the size in your browser 
preferences. For more information, see your browser!s help files.

This section contains the following topics:

! Section 2.1.1, "Sending a Mail Message,# on page 20

! Section 2.1.2, "Sending a Phone Message,# on page 21

! Section 2.1.3, "Writing a Note,# on page 22

! Section 2.1.4, "Sending or Receiving an Internet Location,# on page 23

2.1.1  Sending a Mail Message

1 In the GroupWise WebAccess main window, click New > Mail.

2 Click Address Book to add recipients in the To, CC, and BC fields. 

or

Type a recipient!s address in the To, CC, or BC fields. The address can be a GroupWise user ID, 
GroupWise full name, or external e-mail address. Separate each address with a comma.

When you begin typing a name in the To, CC, or BC fields of an item you are creating, Name 
Completion tries to complete the name for you. If Name Completion finds the name you are 
looking for, you can stop typing. If Name Completion doesn!t find it, continue typing: Name 
Completion searches again after each new character you type. If Name Completion finds a 
name that is close to but doesn!t exactly match the one you are looking for, you can use the Up- 
or Down-arrow to scroll to adjacent names in the address book.
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IMPORTANT: Name-completed addresses for all item types come only from the Frequent 
Contacts address book.

3 Type a subject and message.

You can include Web site locations or addresses (URLs) in both the Subject and Message 
boxes.

4 (Optional) Click Spell Check to check the spelling in the message. For this feature to work, 
your browser must be enabled for Java*.

5 (Optional) Click Attach to attach files to the message. For this feature to work, your browser 
must support attachments.

6 (Optional) Click Send Options to select a security setting (classification), assign a priority 
(high, standard, low), request a reply, or select to receive return notification.

7 Click Send.

If a Web server outage occurs while you are composing a message, your message is not lost when 
you click Send. It is captured and appears at the bottom of the WebAccess Login page so that you 
can retrieve it when your Web server comes back up and you log into WebAccess again.

2.1.2  Sending a Phone Message

GroupWise phone messages are similar to paper-based While You Were Out messages. You send 
GroupWise phone messages to inform other users of calls and their details. GroupWise phone 
messages do not send spoken messages.

1 In the GroupWise WebAccess main window, click New > Phone.

2 Click Address Book to add recipients in the To field. 

or

Type a recipient!s address in the To field. The address can be a GroupWise user ID, GroupWise 
full name, or external e-mail address. Separate each address with a comma.
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IMPORTANT: Name-completed addresses for all item types come only from the Frequent 
Contacts address book.

3 Type the caller, company, and phone information.

4 Type a message.

You can include Web site locations or addresses (URLs) in the Message field.

5 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.

6 (Optional) Click Attach to attach files to the message. For this feature to work, your browser 
must support attachments.

7 (Optional) Click Send Options to select a security setting (classification), assign a priority 
(high, standard, low), request a reply, or select to receive return notification.

8 Click Send.

2.1.3  Writing a Note

1 In the GroupWise WebAccess main window, click New > Note.

2 Click Address Book to add recipients in the To, CC, and BC fields. 

or

Type a recipient!s address in the To, CC, or BC field. The address can be a GroupWise user ID, 
GroupWise full name, or external e-mail address. Separate each address with a comma.

To create a personal note that displays only in your Calendar, add only your name or switch to 
a posted note.

3 Specify the month, day, and year you want the note to appear on the recipient!s Calendar.

4 Type a subject and message.

You can include Web site locations or addresses (URLs) in both the Subject and Message fields.

5 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.
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6 (Optional) Click Attach to attach files to the note. For this feature to work, your browser must 
support attachments.

7 (Optional) Click Send Options to select a security setting (classification), assign a priority 
(high, standard, low), request a reply, or select to receive return notification.

8 Click Send.

For information on creating an appointment, see Section 4.1, "Scheduling Appointments,# on 
page 57. For information on creating a task, see Section 4.2, "Sending Tasks,# on page 61.

2.1.4  Sending or Receiving an Internet Location

WebAccess allows you to send a Web site location, or URL, to another user. WebAccess formats any 
URL in the Message box into a shortcut to the Web site. The recipient who opens your message in 
WebAccess can click the shortcut to open a second browser window that displays the Web site.

2.2  Managing Items You Receive
Reading and managing mail messages, appointments, tasks, or notes in WebAccess is as simple as 
clicking your mouse to open the item.

! Section 2.2.1, "Opening an Item in Your Mailbox,# on page 23

! Section 2.2.2, "Searching for an Item,# on page 23

! Section 2.2.3, "Replying to an Item You Receive,# on page 24

! Section 2.2.4, "Deleting Items You Receive,# on page24

! Section 2.2.5, "Undeleting Items,# on page 25

! Section 2.2.6, "Marking an Item Unread (Read Later),# on page 25

! Section 2.2.7, "Marking an Item Read,# on page 26

! Section 2.2.8, "Forwarding a Mail or Phone Message,# on page 26

2.2.1  Opening an Item in Your Mailbox

In WebAccess, all GroupWise items are opened the same way: in the Item List, click the Subject or 
From field of the item, or right-click it > click Open.

Options in an open item vary depending on the item.

Appointments, tasks, and notes can be accepted, declined, or delegated; right-click an item > click 
Accept, Decline, or Delegate. You can also click Accept, Decline, or Delegate on the toolbar.

2.2.2  Searching for an Item

To perform a search for a specific item, you can either use the Find tool on the Main Window, or you 
can use the Search tool.

Using Find

1 Type the word you want to search for in the Find field.

2 Click Find. The results are displayed in the message list.
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Using the Search Tool

1 From the GroupWise WebAccess main window, click the  icon.

2 To search for specific text, click Full Text or Subject, then type the words you are looking for in 
the text box.

3 To search for a name, click From or To/CC, then type the name in the text box.

4 Select each item type you are looking for.

5 Select each item source you are looking for.

6 In the Search In list, click the folders you want to search in.

If you are searching in a folder in the Cabinet, you might need to click the plus sign next to the 
Cabinet to display the Cabinet folders. If you select Mailbox, your Sent Items folder is included 
in the search. If you do not select a folder, all listed folders are included in the search.

7 Click Find.

2.2.3  Replying to an Item You Receive

You can reply to an item you receive. You can reply to the item!s author or to everybody who 
originally received the item.

1 Click the Mailbox icon in the Folder List or Toolbar.

or

Click the Calendar icon in the Folder List, then go to the date of the appointment, task, or note.

2 Click the message, appointment, task, or note to open it.

or

Right-click the item > click Reply.

3 Click Reply to Sender or Reply to All to open a Reply form.

Reply to Sender sends a reply to the sender only. Reply to All sends a reply to the sender and all 
recipients of the original item.

Choose whether to include the original message in your reply.

4 Type your message.

You can include Web site locations or addresses (URLs) in the Message field.

5 Click Send.

2.2.4  Deleting Items You Receive

You can delete Items you receive and place them in the Trash.

1 Click the Mailbox icon in the Folder List.

or

To delete an item you have moved to a folder, click the folder in the Folder List.

or
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To delete an appointment, task, or note you already accepted, click the Calendar icon in the 
Folder List or Nav Bar.

2 Locate the items in the Item List.

3 Select the items, then click Delete at the top of the Item List.

or

Click the item to open it, then click Delete.

or

Select the items and drag them to the Trash.

or

Select the items, right-click them > click Delete.

The items are removed from your Mailbox or Calendar. The status of the items is also updated in the 
sender!s Mailbox or Calendar to show you deleted the item. As long as the items remain in your 
Trash, you can undelete them. 

2.2.5  Undeleting Items

You can undelete items you deleted (unless you have emptied the Trash). Items emptied from the 
Trash cannot be undeleted.

1 Click the Trash icon in the Folder List.

2 Select the items, then click Undelete at the top of the Item List.

or

Click the item to open it, then click Undelete.

or

Right-click the items > click Undelete,

or

Drag the items out of the Trash folder and drop them onto another folder icon.

The items are moved from your Trash to the folder from which they were originally deleted. 

2.2.6  Marking an Item Unread (Read Later)

If you have opened and read an item, you can mark it as unread. This changes the item!s icon in the 
Item List back to the icon of an unopened item. You might want to mark an item as unread if that 
item requires further action or if you don!t want that item to get lost among the other opened items in 
you Item List. 

1 Click the Mailbox icon in the Folder List.

2 Locate the item in the Item List.

3 Select the item, then click Read Later at the top of the Item List.

or

Right-click the item > click Read Later

or

Click the item to open it, then click Read Later.
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Marking an item Read does not change the status of the item in Properties. For example, if you have 
opened an item, then marked the item unread, the sender of the item sees the item status as opened in 
Properties.

2.2.7  Marking an Item Read

1 Click the Mailbox icon in the Folder List.

2 Locate the item in the Item List.

3 Select the item, then click Mark Read at the top of the Item List.

or

Right-click on the item and choose Mark Read

or

Click the item to open it, then click Mark Read.

Marking an item Read changes the status of the item in Properties. For example, if you have not 
opened an item, but you marked the item Read, the sender of the item sees the item status as opened 
in Properties.

2.2.8  Forwarding a Mail or Phone Message

1 Click the Mailbox icon in the Folder List.

2 Click the mail or phone message to open it.

3 Click Forward. 

or

Right-click the item > click Forward. The original message is included as an attachment to the 
new message.

4 Click Address Book to add recipients in the To, CC, and BC fields. 

or

Type a recipient!s address in the To, CC, or BC field. The address can be a GroupWise user ID, 
GroupWise full name, or external e-mail address. Separate each address with a comma.

5 Type a message.

You can include Web site locations or addresses (URLs) in the Message field.

6 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.

7 (Optional) Click Attach to attach files to the message. For this feature to work, your browser 
must support attachments.

8 Click Send.

2.3  Managing Items You Send
After you send an item, you can check its status to see if it has been delivered, read, deleted, and so 
forth. You can also retract a message, if it has not been opened. You can also move items into 
different folders to keep your GroupWise Mailbox organized.

! Section 2.3.1, "Checking the Status of an Item You Send,# on page 27
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! Section 2.3.2, "Deleting or Retracting an Item You Send,# on page 28

! Section 2.3.3, "Resending Items,# on page 28

2.3.1  Checking the Status of an Item You Send

1 Click the Sent Items icon in the Folder List. 

2 Click the item in the Item List, or right-click it > click Open. 

3 Click the Properties tab.

4 For more detailed status information, click Advanced Properties. 
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2.3.2  Deleting or Retracting an Item You Send

1 Click the Sent Items icon in the Folder List. 

2 Click the item in the Item List to open it.

or

Right-click the item > click Delete.

3 To delete the item from your Mailbox only, click Delete from This Mailbox.

or

To retract the item from your Mailbox and from all recipients! Mailboxes, click Delete from All 
Mailboxes.

A mail message or phone message is retracted only if the recipient has not yet opened it. An 
appointment, note, or task is retracted even if the recipient has already opened and accepted it. 

2.3.3  Resending Items

Use Resend to send an item a second time, perhaps with corrections.

1 Click the Sent Items folder in the Folder List.

2 Click the item in the Item List to open it.

3 (Optional) Select Retract Original Item to retract the original item.

4 Make changes to the item if necessary, then click Send on the toolbar.

You can check the Properties of the original item to see if GroupWise was able to retract it. Right-
click the item in the Sent Items folder, then click Properties. Mail and phone messages cannot be 
retracted if they have already been opened.

2.4  Printing from WebAccess
Printing from WebAccess depends on the printing capabilities of your Web browser.

1 Click any message in the Item List to open it.

2 Click in the message text.

3 Use your browser!s print feature to print the message.

For example, to print using Mozilla* Firefox*, click File > Print.

If your browser!s print feature prints the message in a format that loses information, click Print 
View to display a printer-friendly version of the message in a new browser window, then print 
the message from the new window.

2.5  Using the Folder List
GroupWise WebAccess provides folders to help store and organize the items you send and receive. 
For example, you can group all items related to a particular task or subject together. All folders are 
subfolders of your user folder. The user folder represents your user!s home view, and contains all of 
your GroupWise information. 

The Folder List lets you select which folder you want to open. The contents of the currently opened 
folder are displayed in the Item List.
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Click + and - to expand and collapse personal folders.

For information about the individual folders you might have in your Folder List, see the following:

! Section 2.5.1, "Creating a Folder,# on page 29

! Section 2.5.2, "Deleting Folders,# on page 30

! Section 2.5.3, "Sharing a Folder,# on page 30

! Section 2.5.4, "Moving an Item to a Folder,# on page30

! Section 2.5.5, "Moving an Item to Another Folder,# on page 31

! Section 2.5.6, "Viewing Items in a Find Results Folder,# on page 31

! Section 2.5.7, "Using the Checklist Folder,# on page32

For more information, see the following: 

! Using Folders in your Folder List, see Section 1.3.3, "Folder List,# on page 14.

! Making folders public by sharing them, see Section 2.6, "Working with Shared Folders,# on 
page 33.

! Storing unfinished items in a predefined folder called Work In Progress, see Section 2.9.3, 
"Saving an Unfinished Item,# on page 40.

! Using rules to sort items into folders, see Section 7.3, "Using Rules,# on page 90.

2.5.1  Creating a Folder

1 In the Folder List click Manage Folders, or right-click a folder, then select Add Folder.

2 Type a name for your new folder in the Folder Name field.
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3 Select the place in the Folder List where you want to add the folder. By default, the folder is 
added as the first folder in the Cabinet.

For example, to add a folder at the same level as the Mailbox folder, select the Down button 
next to the Mailbox folder. To add a folder to the Mailbox folder, select the Right button next to 
the Mailbox folder.

4 Click OK.

If you create a folder, then decide you want it in a different position, use the Manage Folders icon in 
the toolbar to move the folder to a new position in the Folder List.

2.5.2  Deleting Folders

You cannot delete system folders, including the Mailbox, Unopened Items, Sent Items, Calendar, 
Checklist, Cabinet, Work In Progress, Junk Mail, and Trash folders.

1 Right-click the folder you want to delete, then click Delete.

2 Click OK to confirm that you want to delete the folder and all of its messages.

You can also use the Manage Folders icon in the toolbar to delete folders.

1 In the Folder List, click Manage Folders, or right-click a folder > and click Delete Folder.

2 Click the folder you want to delete, then click Delete to confirm that you want to delete the 
folder and all its contents.

For more information, see Section 1.3.3, "Folder List,# on page 14.

2.5.3  Sharing a Folder

1 In the toolbar, click the Manage Folders icon.

2 Select Share folder, then select the folder to share.

3 In the Name field, type the name of the user you want to share the folder with.

or

Select the Address Book to search and select user names.

4 When the user's name appears in the field, click Add User to move the user into the Shared List.

5 Select the access options you want for each user.

6 Repeat Steps 3-5 for each user you want to share the folder with.

7 Click Save.

8 When you're done, close the Manage Folders window.

For more information about shared folders, see Section 2.6, "Working with Shared Folders,# on 
page 33.

2.5.4  Moving an Item to a Folder

1 To move an item you received, click the Mailbox icon in the Folder List.

or
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To move an appointment, task, or note you already accepted, click the Calendar icon in the 
Folder List or on the Nav Bar.

2 Locate the item in the Item List.

3 Select the item, then click Move at the top of the Item List.

or

Click the item to open it, then click Move.

or

Right-click the item > click Move.

4 Click the folder where you want to move the item. If you are moving the item to a folder in the 
Cabinet, you might need to click the plus sign (+)  next to the Cabinet to display the Cabinet 
folders. 

You can also move items to the Checklist folder to create a checklist. For more information, see 
Section 2.5.7, "Using the Checklist Folder,# on page32.

To view archived items, you must use a different GroupWise client. You cannot access your 
archived files using the GroupWise WebAccess client.

2.5.5  Moving an Item to Another Folder

You can drag and drop items from folder to folder. You can select more than one item at a time.

1 To move an item you received, click the Mailbox icon in the Folder List or Nav Bar.

or

To move an appointment, task, or note you have already accepted, then click the Calendar icon 
in the Folder List or Nav Bar.

or

To move an item you sent, click the Sent Items icon in the Folder List.

2 Locate the item in the Item List.

3 Select the item, then click Move at the top of the Item List.

or

Click the item to open it, then click Move.

or

Right-click an item > click Move.

4 Click the folder where you want to move the item. If you are moving the item to a folder in the 
Cabinet, you might need to click the plus sign (+)  next to the Cabinet to display the Cabinet 
folders. 

2.5.6  Viewing Items in a Find Results Folder

A Find Results folder is a folder that displays the results of a query. When the folder is opened, 
GroupWise examines the search criteria defined for the folder, searches for everything specified, 
then displays everything it finds in the Item List. You can act on items in a Find Results folder the 
same way you act on items in any folder, such as opening, forwarding, printing, copying, moving, or 
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deleting them, but the original item remains stored in the folder where the search found it. This 
means that if you move or delete an item from a Find Results folder, the item is deleted from the 
Item List, but not from the original location. The next time you open the Find Results folder, the 
search is performed again and the item is once again displayed.

Although you cannot create new Find Results folders using WebAccess, you can use folders you 
created using the GroupWise Client for Windows. However, to ensure that you are viewing the most 
recent information in the folder and not a cached copy, you should click Update before opening a 
Find Results folder.

2.5.7  Using the Checklist Folder

Use the  Checklist folder to create a task list. You can move any items (mail messages, phone 
messages, notes, tasks, or appointments) to this folder and arrange them in the order you want. You 
can mark items Complete. You can assign items a due date, but the items do not display in your 
Calendar. The Checklist folder is a system folder. 

In the Windows version of GroupWise, you can mark items to display in the Checklist folder 
without actually moving them. You cannot do this in GroupWise WebAccess. However, if you 
marked items to display in the Checklist folder in the Windows version of GroupWise, GroupWise 
WebAccess lets you view the items in the Checklist folder. 

In the Windows version of GroupWise, you can create a checklist area at the top of any folder if you 
have selected the Checklist display setting for the folder. This checklist displays in its original folder 
and in the Checklist folder. You cannot do this in GroupWise WebAccess. However, if you have 
created checklists in multiple folders in the Windows version of GroupWise, GroupWise 
WebAccess lets you view the items in the Checklist folder. 

In the previous version of GroupWise WebAccess, a Task List folder listed all the task items in your 
Mailbox and Calendar. The Checklist folder replaces the Task List folder.

This section contains the following topics:

! "Creating a Checklist in the Checklist Folder# on page 32

! "Moving an Item to the Checklist Folder# on page 33

! "Assigning a Due Date to an Item in the Checklist Folder# on page 33

! "Marking a Checklist Item Complete# on page 33

! "Unmarking a Checklist Item# on page 33

Creating a Checklist in the Checklist Folder

1 Move items to the Checklist folder.

For information, see "Moving an Item to the Checklist Folder# on page 33.

2 To arrange the items in the order you want, click an item, then click the toolbar icons to move 
the item up, down, or to the top or bottom of the checklist.

3 To assign a due date to an item, open the item, click Checklist > Activate Checklist Due Date > 
select a due date > Save > Close.

The due date displays in the Due Date column in the Item List.
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Moving an Item to the Checklist Folder

1 To move an item you received, click the Mailbox icon in the Folder List or Nav Bar.

or

To move an appointment, task, or note you have already accepted, click the Calendar icon in 
the Folder List.

2 Locate the item in the Item List.

3 Select the item, then click Move at the top of the Item List.

or

Click the item to open it, then click Move.

or

Drag the item and drop it on the Checklist folder.

or 

Right-click the item > click Move.

4 Click the Checklist folder. 

Assigning a Due Date to an Item in the Checklist Fo lder

1 Click the Checklist folder.

2 Locate the item in the Item List.

3 Click the item to open it, or right-click the item > click Open > Checklist.

4 Click Activate Checklist Due Date, select a due date, then click Save > Close. 

Marking a Checklist Item Complete

1 Click the Checklist folder.

2 Locate the item in the Item List.

3 Click the check box to the left of the item, then click Complete at the top of the Item List.

or

Right-click the item and click Complete.

Items that have been marked Complete have a check mark next to them. 

Unmarking a Checklist Item

1 Click the item to open it.

2 Click Checklist.

3 Deselect Complete.

4 Click Save, then click Close.

2.6  Working with Shared Folders
A shared folder is like any other folder in your Cabinet, except other people have access to it and it 
appears in their Cabinets. You can create shared folders or share existing personal folders in your 
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Cabinet. You choose whom to share the folder with, and what rights to grant each user. Users can 
then post messages to the shared folder, drag existing items into the folder, and create discussion 
threads. You cannot share system folders, which include the Mailbox, Unopened Items, Sent Items, 
Calendar, Task List, Checklist, Cabinet, Work In Progress, Junk Mail, and Trash folders.

If you place a document in a shared folder, people with rights to the shared folder don't 
automatically have rights to edit the document. Before they can edit the document, you must give 
them Edit rights on the Document Sharing tab.

You can share personal folders with other users. Recipients of the shared folder receive a 
notification explaining that you have shared the folder with them. They can then accept the folder or 
decline the folder.

This section contains the following topics:

! Section 2.6.1, "Sharing a Folder,# on page 34

! Section 2.6.2, "Accepting a Shared Folder,# on page 35

! Section 2.6.3, "Posting an Item to a Shared Folder,# on page 35

2.6.1  Sharing a Folder

1 Click Manage Folders, then click the Share Folders tab.

2 Select the folder you want to share or modify permissions for. Folders available for sharing are 
underlined.

3 In the Name box, type the GroupWise names or GroupWise user IDs of the people with whom 
you want to share the folder, then click Add to add them to the Shared list.

or

Click Address Book to use the Address Book to add names to the Shared list.
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After you add a shared folder recipient, the Status column displays Pending until the recipient 
accepts or declines the shared folder.

4 If desired, change the recipient!s shared folder rights.

! Read: Lets the user read items in the folder. 

! Add: Lets the user add items to the folder. 

! Edit: Lets the user edit items in the folder.

! Delete: Lets the user delete items from the folder.

5 Click Save if you changed any shared folder rights.

or

Click Close.

2.6.2  Accepting a Shared Folder

1 Click the Mailbox icon in the Folder List.

2 Click the shared folder notification to open it.

3 Click Accept Folder to open the Accept Shared Folder dialog box.

4 If you want to change the name of the folder (in your Folder List only), type a new name in the 
Folder Name field. 

5 In the Folder List, select the location where you want the folder to be placed.

6 Click OK to add the folder.

2.6.3  Posting an Item to a Shared Folder

1 In the Folder List, open the shared folder you want to post the item to.

2 At the top of the Item List, click Post Item to This Folder to display a Message form.
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3 Type a subject and message.

You can include Web site locations or addresses (URLs) in both the Subject and Message fields.

4 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.

5 (Optional) Click Attach to attach files to the message. For this feature to work, your browser 
must support attachments.

6 Click Post to add the message to the shared folder. 

2.7  Printing Items
1 In the Item List in your Mailbox, open the item you want to print.

2 Click File > Print.

3 Select all the options you want.

4 Click Print.

When printing is complete, close the item.

2.8  Using Proxy
Proxy lets a GroupWise user access another GroupWise user!s Mailbox to perform various actions, 
such as reading, sending, accepting, and declining items, on behalf of the user. This means that you 
can manage another user!s Mailbox (including the Calendar), or you can allow another user to 
manage your Mailbox.

IMPORTANT: You can proxy for a user in a different post office or domain, as long as that person 
is in the same GroupWise system. You cannot proxy for a user in a different GroupWise system.

Before you can use Proxy to manage another user!s Mailbox, that person must grant you proxy 
access to his or her Mailbox. The same is true if you want someone to act as your proxy; you must 
give that person proxy access to your Mailbox.

Proxy access enables the proxy to open the other person!s Mailbox, while logged in to his or her 
own Mailbox, without knowing the person!s GroupWise user ID and Mailbox password. It also 
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establishes the rights the proxy has to the Mailbox. A proxy!s rights determine the extent to which 
the proxy can manage the person!s Mailbox. For example, the proxy might be given rights to read 
and write (send) all item types or only be given rights to read Calendar items (appointments, tasks, 
and notes). 

In addition to providing specific users with proxy access to your Mailbox, you can establish a 
default level of proxy access. The default level of proxy access is given to all GroupWise users to 
whom you haven!t explicitly given proxy access. 

You establish the default level of proxy access by modifying the <All User Access> entry in your 
Proxy Access list. For example, if you want to enable all GroupWise users to view your Calendar, 
you can modify the <All User Access> entry to give Read rights to your appointments, tasks, and 
notes. By default, <All User Access> does not allow any access to your Mailbox.

This section contains the following topics:

! Section 2.8.1, "Managing Someone Else!s Mailbox,# on page 37

! Section 2.8.2, "Granting Proxy Access to Your Mailbox,# on page 38

! Section 2.8.3, "Granting All Users Access to Your Mailbox,# on page 39

2.8.1  Managing Someone Else!s Mailbox

Before you can act as a proxy for someone, that person must give you proxy rights in his or her 
Access List in Options. The amount of access you have depends on the rights you have been given. 

1 In the GroupWise WebAccess main window, click the Proxy icon.

The Proxy list contains the names of all users whose Mailboxes you!ve previously acted as a 
proxy for. 

2 If the user!s whose Mailbox you want to access is listed in the Proxy list, click the user. 
Otherwise, continue with the next step.

3 Click Address Book to open the GroupWise Address Book.

or

If you know the full GroupWise address (userID.post_office.domain) of the person whose 
Mailbox you want to access, type the address in the Name field, then click Login.
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4 Specify the search criteria needed to find the user whom you want to be a proxy, then click 
Search. In the list of users that is displayed as a result of the search, select the user, click Select 
(at the top of the list of users), then click Login to close the Address Book and display the user!s 
Mailbox.

5 When you have finished your work in the other person's Mailbox, click the folder list header 
drop-down list, then click your own name to return to your Mailbox.

2.8.2  Granting Proxy Access to Your Mailbox

1 From the GroupWise WebAccess main window, click the Options icon on the toolbar.

2 Click Proxy Access.

For a user to have proxy rights to your Mailbox, you must add the user to the Proxy Access list. 

3 Click Add Entry to display the Add Proxy Access page.

4 Click Address Book to open the GroupWise Address Book.

or

If you know the GroupWise user ID of the person you want to assign as a proxy, specify the 
user ID in the Name field, then skip to Step 6.

5 Enter the search criteria needed to find the user whom you want to be a proxy, then click 
Search. In the list of users that is displayed as a result of the search, select the user, click Select 
(at the top of the list of users), then click OK to close the Address Book and display the user in 
the Name field.

6 Select the rights you want to give the proxy:

! Mail/Phone: Select Read to enable the proxy to read mail and phone messages. Select 
Write to enable the proxy to create and send mail and phone messages.

! Appointments: Select Read to enable the proxy to read appointments. Select Write to 
enable the proxy to create and send appointments.

! Reminder Notes: Select Read to enable the proxy to read notes. Select Write to enable the 
proxy to create and send notes.

! Tasks: Select Read to enable the proxy to read tasks. Select Write to enable the proxy to 
create and send tasks.

! Subscribe to My Alarms: This applies only if the proxy is using the GroupWise client 
for Windows. Receiving alarms is not supported in GroupWise WebAccess. It enables the 
proxy to receive any appointment alarms you set. 
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! Subscribe to My Notifications: This applies only if the proxy is using the GroupWise 
client for Windows. Receiving notifications is not supported in GroupWise WebAccess. 
This option enables the proxy to receive notifications through GroupWise Notify. 

! Modify Options/Rules/Folders: Select this option to enable the proxy to change the 
options in your Mailbox and to add, delete, or modify folders. The proxy can edit any of 
your Options settings except for the Proxy Access settings.

! Read Items Marked Private: Select this option to enable the proxy to see any items that 
are marked Private. If you don!t give the proxy this right, all items marked Private in your 
Mailbox are hidden from that proxy.

7 Click Save to add the proxy to the Proxy Access list.

8 Repeat Steps 3 through 7 to add additional proxies.

or

Click Close to close the Proxy Access dialog box.

2.8.3  Granting All Users Access to Your Mailbox

The Proxy Access list contains an entry called <All User Access>. This entry applies to any 
GroupWise users who you have not explicitly added to the Proxy Access list. By default, the <All 
User Access> entry has no proxy rights to your Mailbox. However, you can modify the entry to 
grant rights to all users.

1 From the GroupWise WebAccess main window, click the Options icon on the toolbar.

2 Click Proxy Access.

3 Click <All User Access> to display the proxy rights assigned to this entry.

4 Select the rights you want to give the <All User Access> entry:

! Mail/Phone: Select Read to enable all users to read mail and phone messages. Select 
Write to enable all users to create and send mail and phone messages.

! Appointments: Select Read to enable all users to read appointments. Select Write to 
enable all users to create and send appointments.

! Reminder Notes: Select Read to enable all users to read notes. Select Write to enable all 
users to create and send notes.

! Tasks: Select Read to enable all users to read tasks. Select Write to enable all users to 
create and send tasks.

! Subscribe to My Alarms: This applies only if proxies are using the GroupWise client for 
Windows. Receiving alarms is not supported in GroupWise WebAccess. This enables all 
users to receive any appointment alarms you set. 

! Subscribe to My Notifications: This applies only if proxies are using the GroupWise 
client for Windows. Receiving notifications is not supported in GroupWise WebAccess. 
This option enables all users to receive notifications given through GroupWise Notify. 

! Modify Options/Rules/Folders: Select this option to enable all users to change the 
options in your Mailbox and to add, delete, or modify folders. Users can edit any of your 
Options settings except for the Proxy Access settings.

! Read Items Marked Private: Select this option to enable all users to see any items that 
are marked Private. If you don!t give the users this right, all items marked Private in your 
Mailbox are hidden from the users.
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5 Click Save to save the changes to the <All User Access> entry.

6 Click Close to close the Proxy Access dialog box.

2.9  Saving Items in Your Mailbox
This section contains the following topics:

! Section 2.9.1, "Saving an Item,# on page 40

! Section 2.9.2, "Saving Status Information,# on page 40

! Section 2.9.3, "Saving an Unfinished Item,# on page 40

2.9.1  Saving an Item

Saved items remain in your Mailbox and Calendar as well as being copied to the location you 
specify. Items saved to disk are saved in HTML format with a .html extension so that they can be 
opened in your Web browser. Attachments are saved in their original format.

1 In your Mailbox, open the item you want to archive.

2 Click File > Save Page As.

3 Type a name for the file.

4 Select the location from the Save in folder drop-down menu

or

Select Browse for other folders to browse for a different location.

The saved item remains in your GroupWise folder until you delete it or it is deleted automatically.

2.9.2  Saving Status Information

1 Right-click an item, then click Properties.

2 Click File > Save Page As.

GroupWise gives the item a temporary filename. You can change the filename and default 
folder to save the file.

3 Click Save.

2.9.3  Saving an Unfinished Item

1 In an open item, click the Save icon.

2 Click the folder you want to save the item to, then click OK.

The draft message is placed in the folder you chose in Step 2. The default folder for unfinished 
messages is the Work In Progress folder .

2.10  Opening and Emptying the Trash
All deleted mail and phone messages, appointments, tasks, documents, and reminder notes are 
stored in the Trash. Items in the Trash can be viewed, opened, or returned to your Mailbox until the 
Trash is emptied. (Emptying the Trash removes items in the Trash from the system.) 
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You can empty your entire Trash, or empty only selected items. Items in the Trash are emptied 
according to the way your GroupWise administrator specifies, or you can empty the Trash manually. 
The system administrator can specify that your Trash is emptied automatically on a regular basis.

This section contains the following topics:

! Section 2.10.1, "Opening Your Trash,# on page 41

! Section 2.10.2, "Saving an Item That Is in Your Trash,# on page 41

! Section 2.10.3, "Emptying the Trash,# on page 41

! Section 2.10.4, "Emptying Selected Items from the Trash,# on page 41

! Section 2.10.5, "Undeleting Items from the Trash,# on page 41

2.10.1  Opening Your Trash

1 In your Mailbox, click the Trash folder.

You can open, save, and view information on items in the Trash. You can also permanently remove 
items or return them to the Mailbox. Right-click an item in the Trash to see more options.

2.10.2  Saving an Item That Is in Your Trash

You can save items that are in the Trash the same way you save any other item. See Section 2.9.1, 
"Saving an Item,# on page 40 for more information.

2.10.3  Emptying the Trash

1 In your Mailbox, right-click the Trash folder, then click Empty Trash.

2.10.4  Emptying Selected Items from the Trash

1 In your Mailbox, click the Trash folder.

2 Select one or more items.

3 Click Empty Selected Items, then click OK.

2.10.5  Undeleting Items from the Trash

When you delete an item, the item is moved to the Trash. The item remains in the Trash until you 
purge the item from the Trash or purge all items by emptying the Trash. The Trash works like other 
folders in your Folder List, which means you can list the items in the Trash as well as open and view 
item contents. You can also undelete items from the Trash. Undeleted items return to the folders 
from which they were deleted. 

The Windows version of GroupWise includes an option for automatically emptying the Trash after a 
specified number of days. If this option has been set, either by you or by the GroupWise system 
administrator, items in the Trash are automatically purged after the specified number of days.

To undelete items from your Trash folder,

1 Click the Trash folder.
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2 Select the item, then click Undelete at the top of the Item List.

or

Click the item to open it, then click Undelete.

The item is moved from your Trash to the folder from which it was originally deleted. 
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3Working with Items in Your 
Mailbox

GroupWise® provides many options for sending and receiving different kinds of e-mail.

! Section 3.1, "Understanding GroupWise Item Types,# on page 43

! Section 3.2, "Sending and Receiving Items,# on page 44

! Section 3.3, "Attaching Files,# on page 48

! Section 3.4, "Managing Sent Items,# on page 50

! Section 3.5, "Managing Received Items,# on page 52

3.1  Understanding GroupWise Item Types
Every day you communicate in a variety of ways. To accommodate these needs, GroupWise delivers 
your items using a variety of item types. Each item type is explained below.

Mail

A mail message is for basic correspondence, such as a memorandum or letter.

Appointment

An appointment lets you invite people to and schedule resources for meetings or events. You can 
schedule the date, time, and location for the meeting. You can use posted appointments to schedule 
personal events such as a doctor's appointment, a reminder to make a phone call at a certain time, 
and so forth. Appointments display on the Calendar. See Section 4.1, "Scheduling Appointments,# 
on page 57.

Task

A task lets you place a to-do item on your own or on another person's Calendar after the task has 
been accepted. You can schedule a due date for the task and include a priority (such as A1). 
Uncompleted tasks are carried forward to the next day. See Section 4.2, "Sending Tasks,# on 
page 61.

TIP: You can also create a checklist that is not associated with your Calendar. In this type of 
checklist, any item type (mail, appointment, task, reminder note, phone message) can be used. For 
information, see Section 3.5.5, "Creating a Checklist,# on page 54.

Reminder Note

A reminder note is posted on a specific date on your own or another person's Calendar. You can use 
reminder notes to remind yourself or others of deadlines, holidays, days off, and so forth. Posted 
reminder notes are useful as reminders for birthdays, vacations, paydays, and so forth. See 
Section 4.3, "Sending Reminder Notes,# on page 63.
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Phone Message

A phone message helps you inform someone of a phone call or visitor. You can include such 
information as caller, phone number, company, urgency of the call, and so forth. You cannot answer 
your phone from a phone message. See Section 3.2.2, "Sending Phone Messages,# on page 46.

3.2  Sending and Receiving Items
This section contains the following topics:

! Section 3.2.1, "Sending Mail Messages,# on page 44

! Section 3.2.2, "Sending Phone Messages,# on page 46

! Section 3.2.3, "Adding A Signature to Items You Send,# on page 46

! Section 3.2.4, "Using Spell Checker,# on page 47

! Section 3.2.5, "Undoing the Last Text Action,# on page 48

3.2.1  Sending Mail Messages

A mail message has a primary recipient, subject line, and can be carbon copied and blind copied to 
other users. You can also attach files, sounds, movies, and OLE objects to your mail messages.

CC (Carbon Copy)

Carbon copy recipients (CC) receive a copy of an item. CC recipients are users who would benefit 
from the information in an item, but are not affected by or directly responsible for it. All recipients 
can see that a carbon copy was sent. They can also see the names of the CC recipients.

BC (Blind Copy)

Blind copy recipients (BC) receive a copy of an item. Other recipients receive no information about 
blind copies. Only the sender and the blind copy recipient know that a blind copy was sent. If a 
recipient replies and chooses Reply to All, the blind copy recipient does not receive the reply.

1 Click New on the toolbar.

You can select a different mail view by clicking the down-arrow in .
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A blank Mail Message window displays by default (or you can click New > Mail on the 
toolbar).

2 In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC fields.

or

To select usernames from a list, click Address Book on the toolbar, search for each user!s name, 
double-click or select each user, then click OK.

3 Type a subject.

4 Type a message.

You can specify many options, such as making this message a high priority, requesting a reply 
from recipients, and more, by clicking the Send Options tab.

5 Include any attachments by clicking the Attachments tab.

6 (Optional) Add a signature by clicking the Signature tab.

7 Click Send on the toolbar.
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3.2.2  Sending Phone Messages

A phone message is a note you can send to notify other GroupWise users of calls they received while 
they were out of the office or unavailable. Phone messages are stored in the recipient's Mailbox. You 
cannot answer your phone from a phone message.

1 Click New > Phone.

2 In the To field, type a username, then press Enter. Repeat for additional users.

or

To select usernames from a list, click Address Book on the toolbar, double-click each user, then 
click OK.

3 Type the name, company, and phone number of the caller.

4 Type the message in the Message field.

5 (Optional) Add a signature by clicking the Signature tab.

For more information, see Section 3.2.3, "Adding A Signature to Items You Send,# on page 46.

6 Click Send on the toolbar.

3.2.3  Adding A Signature to Items You Send

Use Signatures to insert a signature or tagline at the end of items you send. For example, you can 
have GroupWise automatically list your name, phone number, and e-mail address at the bottom of 
every item you send. 

In addition to personal signatures, your system administrator can create a global signature for 
everyone to use. If the system administrator requires the global signature, it is automatically 
appended to all items that are sent. If the system administrator does not require the global signature, 
it is appended to your signature if you already use an existing signature. If you don't have a 
signature, the global signature is not added to sent items if it is not required. When you resend an 
item, the global signature is not automatically added to the message.

1 In the GroupWise WebAccess main window, click the Options icon.

2 Click Signature.
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3 Click Activate Signature.

4 Type your signature text in the box.

5 Click Automatically Add Signature to have GroupWise WebAccess automatically add the 
signature when you send the item. 

or

Click Prompt before adding signature to have GroupWise WebAccess prompt you to add the 
signature when you send the item.

6 Click Save.

When you create a signature, GroupWise WebAccess stores it in your GroupWise Mailbox at 
your post office. The GroupWise Linux and WebAccess clients share the same text signature, 
while the GroupWise Windows client stores signatures in HTML format and allows multiple 
signatures to be stored.

3.2.4  Using Spell Checker

Spell Checker lets you check for misspelled words in the messages you create. It checks for 
misspelled words, duplicate words, and irregular capitalization in items you are creating.

The WebAccess Spell Checker is a Java applet, so your browser must be enabled for Java in order to 
use it.
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When Spell Checker finds a misspelled word, you can replace it with a word Spell Checker 
suggests, edit the word manually, or skip the word.

1 In a message you are creating, click Spell Check.

2 When Spell Checker stops on a word, click any of the available options, or edit the word 
manually.

You can choose from the following options:

Replace: Replaces a misspelled word with a word Spell Checker suggests. To replace a 
misspelled word, double-click the word or click the word, then click Replace. To make your 
own corrections, edit the word in the Replace with field, then click Replace.

Skip:  Skips the word one time. Spell Checker stops the next time it encounters the word.

Sometimes Spell Checker offers no replacement words. If this happens, click Skip or edit the 
text manually in the Replace With field.

The WebAccess dictionary and word lists cannot be modified.

3 When there are no more words to check, click Close.

3.2.5  Undoing the Last Text Action

You can undo the last text action in the Subject or Message field of a message you are composing.

1 Press Ctrl+Z.

3.3  Attaching Files
All GroupWise items you send or receive can include attachments of any file type (for example, text, 
audio, image, video, and application). For this feature to work, your browser must support 
attachments.
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Use Attach File to send one or more files to other users. You can attach a file that exists on your hard 
disk, diskette, or network drive. The recipients can open the attached file, save it, view it, or print it. 
If you change the attached file after you have sent it, the recipients do not see the changes.

This section contains the following topics:

! Section 3.3.1, "Attaching a File to an Item,# on page 49

! Section 3.3.2, "Managing Attached Files,# on page 50

Attaching Files

You can attach one or more files to an item to send to other users. For example, you might want to 
send an expense report to another user or attach an agenda to an appointment. For you to attach files 
to an item, your browser must support attachments.

Viewing Attachments

When you view an attached file, GroupWise WebAccess attempts to convert the file to HTML and 
display it in your browser. If GroupWise WebAccess cannot convert the file, you can try to have 
your browser display the file. Depending on how your browser is configured to handle the file, the 
browser might display the file, launch an application to view the file in its native format, or save the 
file.

Opening Attachments

When you open an attached file, the file is opened in your browser in its native format if your 
browser supports the file format and if your browser is set up with the correct association for the file 
format. In addition, you might be able to edit the file if you have the appropriate plug-in (for 
example, the MSWord plug-in allows you to edit a .doc  file in the browser). If you try to open a 
file with a format that is not supported in your browser or that does not have an association in your 
browser, you are prompted to save the file to disk.

Saving Attachments

You can save attachments in their native format.

3.3.1  Attaching a File to an Item

1 Open a new item.

2 Fill in the To, Subject, and Message fields.

3 Click the Attachments tab, then browse to and select the file or files you want to send.

To remove an attached file, click the attachment, then click Remove.

4 Click Send on the toolbar.

Moving or deleting a file on a disk or network drive does not affect a file you've attached to an item 
and sent.

If you delete an attached file, it is not erased from disk or network drive; it is simply removed from 
the attachment list.
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3.3.2  Managing Attached Files

If you receive an attached file in an e-mail message, you can manage the attachment in one of the 
following ways:

! View allows you to see the attachment in a file rendering view. The file is displayed in a new 
GroupWise window.

! Open allows you to open the attachment in the specified application. If the file!s type hasn!t 
previously been associated with a specific application, you can choose the application from the 
resulting pop-up window.

! Save As allows you to specify where to save the attached file. You can save it to your hard disk, 
diskette, or network drive.

3.4  Managing Sent Items
This section contains the following topics:

! Section 3.4.1, "Confirming Delivery of Items You've Sent,# on page 50

! Section 3.4.2, "Displaying Sent Items,# on page 51

! Section 3.4.3, "Retracting Items You've Sent,# on page 51

! Section 3.4.4, "Checking the Status of Your Items,# on page 51

! Section 3.4.5, "Receiving Notification About Items You Send,# on page 52

! Section 3.4.6, "Requesting a Reply for Items You Send,# on page 52

3.4.1  Confirming Delivery of Items You've Sent

GroupWise provides several ways for you to confirm that your item was delivered.

Track an Item You Sent

You can check the status in the Properties window of any item you've sent. For information, see 
Section 3.4.4, "Checking the Status of Your Items,# on page 51.

Receive Notification When the Item is Opened or Del eted

You can receive notification when the recipient opens or deletes a message, declines an 
appointment, or completes a task. For information, see Section 3.4.5, "Receiving Notification About 
Items You Send,# on page 52.

Request a Reply

You can inform the recipient of an item that you need a reply. GroupWise adds a sentence to the item 
stating that a reply is requested and changes the icon in the recipient's Mailbox to a double arrow. 
For information, see Section 3.4.6, "Requesting a Reply for Items You Send,# on page 52.
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3.4.2  Displaying Sent Items

You might want to display items you previously sent. For example, you can read a sent item, resend 
it with or without corrections, and in some cases, retract it (if it has not already been opened by the 
recipient).

1 Click the Sent Items folder  in the Nav Bar.

All sent items reside in this folder unless they are moved to a folder other than the Mailbox or 
Calendar. If a sent item is moved to another folder, it no longer displays in the Sent Items folder. To 
display sent items that have been moved to other folders, open those folders.

3.4.3  Retracting Items You've Sent

Use Delete to retract a sent item from the recipient's Mailbox. You can retract a mail or phone 
message from those recipients who haven!t yet opened the item. You can retract an appointment, 
reminder note, or task at any time.

1 Click the Sent Items folder in the Nav Bar.

2 Right-click the item you want to retract, then click Delete From This Mailbox or Delete From 
All Mailboxes.

3 Click OK.

To see which recipients have opened your message, right-click the item, then click Properties.

3.4.4  Checking the Status of Your Items

Properties lets you check the status of any item you've sent. For example, you can see when an item 
was delivered and when the recipient opened or deleted the item. If a recipient accepted or declined 
an appointment and included a comment, you'll see the comment in the Properties window. You also 
see if a recipient marked a task Completed.

Properties also shows information about items you receive. You can see who else received the item 
(except for blind copy recipients), the size and creation date of attached files, and more. 

This section contains the following topics:

! "Checking the Status of an Item# on page 51

! "Saving the Status Information of an Item# on page 51

! "Printing the Status Information of an Item# on page 52

Checking the Status of an Item

1 Right-click an item in your Mailbox or Calendar, then click Properties.

The icons next to an item can give also you helpful status information. See Section 1.3.4, "Item 
List,# on page 16.

Saving the Status Information of an Item

1 Right-click an item, then click Properties.

2 Click File > Save Page As.
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GroupWise gives the item a temporary filename. You can change the filename and default 
folder to save the file.

3 Click Save.

Printing the Status Information of an Item

1 Right-click an item, then click Properties.

2 Click File > Print.

3.4.5  Receiving Notification About Items You Send

1 To receive notification for an item, open an item view and click the Send Options tab.

2 In the Return Notification section, specify the type of return receipt you want.

3 Click OK.

3.4.6  Requesting a Reply for Items You Send

1 To request a reply for an item, open an item view, and click the Send Options tab.

2 In the Reply Requested section, specify when you want to receive the reply.

If you select When convenient, "Reply Requested: When convenient# appears at the top of the 
message. If you select Within _ days, "Reply Requested: By xx/xx/xx# appears at the top of the 
message.

3 Click OK.

3.5  Managing Received Items
GroupWise stores all the mail messages, appointments, and other items you receive in your 
Mailbox.

Figure 3-1   Mailbox View

From your Mailbox, you can read items, reply to items, and forward items you've received. You can 
organize items by assigning them to categories or by creating a checklist. You can delegate tasks and 
appointments to other users. You can handle unwanted Internet e-mail with Junk Mail Handling.
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This section contains the following topics:

! Section 3.5.1, "Reading Items You Receive,# on page 53

! Section 3.5.2, "Replying to Items You Receive,# on page 53

! Section 3.5.3, "Forwarding Items to Other Users,# on page 54

! Section 3.5.4, "Printing Items,# on page 54

! Section 3.5.5, "Creating a Checklist,# on page 54

! Section 3.5.6, "Viewing the Source of External Messages,# on page 56

3.5.1  Reading Items You Receive

You can read items you receive in your Mailbox or Calendar. Your Mailbox displays a list of all of 
the items you have received from other users. Posted appointments, tasks, and reminder notes appear 
in your Calendar, not in your Mailbox.

Phone and mail messages stay in your Mailbox until you delete them. Appointments, reminder 
notes, and tasks stay in your Mailbox until you accept, decline, or delete them. When you accept an 
appointment, reminder note, or task, it is moved to your Calendar.

All Mailbox items are marked with an icon.The icons change depending on whether or not the item 
has been opened. For more information, see Section 1.3.4, "Item List,# on page 16.

In addition, all unopened items in your Mailbox are bolded to help you easily identify which items 
and documents you have not yet read. For more information, see Section 2.2.6, "Marking an Item 
Unread (Read Later),# on page 25 and Section 2.2.7, "Marking an Item Read,# on page 26.

Reading Items in Your Mailbox

1 Click the item you want to read.

3.5.2  Replying to Items You Receive

Use Reply to respond to an item. You can reply to everyone who received the original item or to the 
sender only, without needing to create and address a new message. You can also include a copy of 
the original message in your reply. Your reply will include Re: preceding the original subject text. 
You can modify the subject text if you want.

Replying to an Item

1 Open the item you want to reply to.

2 Click Reply on the toolbar.

Click the arrow next to Reply to choose from the following options:

! Reply to Sender (Include Message): Sends a message and a copy of the original 
message to only the sender.

! Reply to Sender: Sends a message to only the sender (without including the original 
message).

! Reply to All (Include Message): Sends a message and a copy of the original message to 
all recipients.

! Reply to All: Sends a message (without including the original message) to all recipients.
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3 Type your message, then click Send on the toolbar.

If the original item included BC or CC recipients and you selected to reply to all, your reply is sent 
to the CC recipients but not to the BC recipients.

3.5.3  Forwarding Items to Other Users

Use Forward to send items you receive and document references to other users. When you forward 
an item, it is sent as an attachment to a mail message. The mail message includes your name and any 
additional comments you have made.

Forwarding an Item

1 Right-click the item you want to forward.

2 Click Forward.

3 Add the names of the users to whom you want to forward the item.

4 Type a message (optional).

5 Click Send on the toolbar.

3.5.4  Printing Items

When you print an item, the From, To, Date, Subject, CC, and attachment names are displayed at the 
top of the page. 

1 In an open item click File > Print.

2 In the Name field, select the printer to use.

3  Select the pages to print, then click Print.

3.5.5  Creating a Checklist

Use the Checklist folder to create a task list. You can move any items (mail messages, phone 
messages, reminder notes, tasks, or appointments) to this folder and arrange them in the order you 
want. Each item is marked with a check box so that you can check off items as you complete them. 

After you have moved an item to the Checklist folder, you can open it, click the Checklist tab, and 
assign it a due date. You can also mark it Completed and set its position in the list from the Checklist 
tab.

The Checklist folder is a system folder. It replaces the Task List folder.

IMPORTANT: If you or your system administrator has set up auto-archiving of items in your 
Mailbox, checklist items are archived based on the original date you received the item, not based on 
the due date you assign it.

This section contains the following topics:

! "Creating a Master Checklist in the Checklist Folder# on page 55

! "Creating a New Item in the Checklist Folder# on page 55

! "Assigning a Due Date to an Item in the Checklist Folder# on page 56
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! "Marking or Unmarking a Checklist Item Completed# on page 56

Creating a Master Checklist in the Checklist Folder

1 Drag items to the Checklist folder.

In the Checklist folder, the items display with a check box to the left of them. When you 
complete an item in the checklist, you can mark it complete by selecting the check box.

You can move items to the Checklist folder from a shared folder only if you are the owner of 
the shared folder.

2 To assign a due date and a numerical position (order) in the Checklist to an item, open the item 
and add this information on the Checklist tab.

You can also create a checklist area in another folder and drag items to the area. After items are in a 
checklist area of any folder, they will also display in the master Checklist folder, even though they 
are still located in the original folder.

Creating a New Item in the Checklist Folder

1 Click the Checklist folder.

2 If no items exist in the Checklist folder, click the down-arrow on the  icon, then 
click Posted Message.

Type a subject and message, click Post on the toolbar, then skip to Step 6.

or

If items already exist in the Checklist folder, follow Steps 3-5 below.
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3 Click the position in the checklist where you want to add a new item. For example, if you want 
the item to be first in the checklist, click the first item.

4 Begin typing the subject text.

5 When you are finished typing the subject text, press Enter.

The item you have created displays as a posted mail item in the position you selected, and the 
item that was originally in that position is moved down one position in the checklist.

6 To add additional information to this item, open it and type additional text on the Mail tab. 

7 To assign a due date to the item, open it, click the Checklist tab, click Due on, then click a date.

Assigning a Due Date to an Item in the Checklist Fo lder

1 Open an item in the Checklist folder.

2 Click the Checklist tab.

3 Select Due on, then click a date.

Marking or Unmarking a Checklist Item Completed

1 Click the box next to the checklist item.

3.5.6  Viewing the Source of External Messages

When you receive or send messages to and from external systems, you can view the source for a 
message. The source includes all the data that is contained in a message.

1 Open an item that you received from an external source.

2 Click the Mime.822 attachment to open it.
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4Scheduling Group and Posted 
Items

You can schedule appointments, tasks, and reminder notes for yourself and other users. You can also 
reserve a block of time with a posted appointment.

For information about how appointments, tasks, and reminder notes differ from other item types, see 
Section 3.1, "Understanding GroupWise Item Types,# on page 43.

If you want to find out whether someone accepted a task or is coming to your meeting, you can 
check for an accepted or declined status in the item's Properties. For more information, see 
Section 3.4.4, "Checking the Status of Your Items,# on page 51. 

Notify can send you a notification when recipients have accepted, declined, or completed items. For 
more information, see Section 3.4.5, "Receiving Notification About Items You Send,# on page 52. 

All scheduled items can be retracted or rescheduled, even if the recipients have already opened and 
accepted them. For more information, see Section 3.4.3, "Retracting Items You've Sent,# on page 51 
and Section 4.1.2, "Rescheduling an Appointment,# on page 59. 

For more information about managing items after they have been sent or received, see Section 3.4, 
"Managing Sent Items,# on page 50 and Section 3.5, "Managing Received Items,# on page 52.

This section contains the following topics:

! Section 4.1, "Scheduling Appointments,# on page 57

! Section 4.2, "Sending Tasks,# on page 61

! Section 4.3, "Sending Reminder Notes,# on page 63

! Section 4.4, "Accepting or Declining Scheduled Items,# on page 64

! Section 4.5, "Accepting or Declining Internet Items,# on page 65

4.1  Scheduling Appointments
Use appointments to schedule blocks of time on a specific date or range of dates.

You can use Busy Search to check for a time when all the users and resources you want for an 
appointment are available.

This section contains the following topics:

! Section 4.1.1, "Scheduling an Appointment for Other Users,# on page 58

! Section 4.1.2, "Rescheduling an Appointment,# on page 59

! Section 4.1.3, "Canceling an Appointment,# on page 59

! Section 4.1.4, "Scheduling an Appointment for Yourself,# on page 59

! Section 4.1.5, "Checking When Everyone Is Available,# on page 60
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4.1.1  Scheduling an Appointment for Other Users

1 Click New > Appointment on the toolbar.

2 In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC fields.

or

To select usernames or resources from a list, click Address Book on the toolbar, search for each 
user!s name, double-click each user, then click OK.

3 Type the location description in the Location field.

4 Specify the start date.

5 Specify a start time and duration. Duration can be in minutes, hours, or days.

6 Specify how you want the appointment to appear as from the Show As drop-down menu. 

Appointments can appear as Busy, Free, Out of the Office, or Tentative.

7 Type a subject and message.

8 If you want to make sure the people and resources for the appointment are available, you can 
do a busy search by clicking Busy Search on the toolbar. See Section 4.1.5, "Checking When 
Everyone Is Available,# on page 60.
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You can specify many options, such as making this appointment a high priority, requesting a 
reply from recipients, and more, by clicking the Send Options tab.

9 Click Send on the toolbar.

4.1.2  Rescheduling an Appointment

If you want to make sure the people and resources for the appointment are available, you can do a 
busy search by clicking Busy Search on the toolbar. 

1 Click the Sent Items folder in the Folder List.

2 Select the appointment to reschedule and open it.

3 In the appointment window, click Resend on the toolbar.

4 Make your changes, then click Send on the toolbar.

4.1.3  Canceling an Appointment

You can cancel an appointment if you scheduled it or if you have the necessary Proxy rights to the 
scheduler's Mailbox.

1 Click the Sent Items folder in the Folder List.

2 Select the appointment you want to cancel.

3 Click Delete From This Mailbox.

4.1.4  Scheduling an Appointment for Yourself

If you are not available for meetings, schedule a posted appointment for those times. When another 
user includes you in an appointment and does a busy search, the user can see you are not available at 
those times, but can still schedule over your appointment.
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Posted appointments are placed in your Calendar on the date you specify. They are not placed in 
your Mailbox or in any other user's Mailbox.

1 On the toolbar, click Posted Appointment.

2 (Optional) Type a subject and a place if necessary.

3 Specify the start date.

4 Specify a start time and duration. Duration can be in minutes, hours, or days.

5 Specify how you want the appointment to appear as with the Show As drop-down menu. 
Appointments can appear as Free, Tentative, Busy, or Out of the Office.

6 (Optional) Type a message.

You can specify many options, such as making this appointment a high priority and more, by 
clicking the Options tab.

7 Click Post on the toolbar.

Posted appointments are placed in your Calendar on the date you specified. They are not placed in 
your Mailbox or in any other user's Mailbox.

4.1.5  Checking When Everyone Is Available

Use Busy Search to find a time when all the people and resources you want to schedule for a 
meeting are available.
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Performing a Busy Search

1 In an appointment you are creating, specify usernames in the To field.

2 Specify the first possible day for the meeting in the Start Date field.

3 Specify the meeting's duration.

4 Click Busy Search on the toolbar.

The legend at the bottom of the Appointment dialog box shows the available times. 

5 Click one of the suggested times to select an available meeting time.

6 Complete and send the appointment.

If you want to do a busy search before creating an appointment, click Busy Search in the 
toolbar.

4.2  Sending Tasks
A task is an item to be completed by a specified date and time that displays on the Calendar. When 
you assign a task to a user, the user can accept or decline the task, but until it is declined or 
completed, the task appears on the user's Tasks List and on the user's Calendar each day.

After it is accepted, a task appears on the Calendar on its start date. When the due date is past, the 
task displays in red on the Calendar. When you mark a task Completed, it no longer carries over to 
the next day on your Calendar.

After you finish a task, you can mark it Completed. As the originator of an assigned task, you can 
have GroupWise send you notification when the task is marked Completed. (You must have Notify 
running to receive notification). A Completed status, including the date and time the task was 
marked Completed, is placed in the Properties window.

TIP: You can also create a checklist that is not associated with your Calendar. In this type of 
checklist, any item type (mail, appointment, task, reminder note, phone message) can be used. For 
information, see Section 3.5.5, "Creating a Checklist,# on page 54.

This section contains the following topics:

! Section 4.2.1, "Assigning a Task to Other Users,# on page 62

! Section 4.2.2, "Assigning a Task to Yourself,# on page 63

! Section 4.2.3, "Marking Tasks Completed,# on page 63
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4.2.1  Assigning a Task to Other Users

1 Click New > Task.

2 In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC fields.

or

To select usernames from a list, click Address, double-click each user, then click OK.

3 Select the date you want the task to begin and the date you want the task to be completed. You 
can select the same date in both fields.

4 Type the subject.

5 (Optional) Type a priority for the task.

The task priority can consist of a character followed by a number. The following are acceptable 
formats: A1, C2, B, 3, and so forth.

6 Type a description of the task.

You can specify many options, such as making this task a high priority, requesting a reply from 
recipients, and more, by clicking the Send Options tab.

7 Click Send on the toolbar.
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4.2.2  Assigning a Task to Yourself

1 Click New > Posted Task.

2 Select the date you want the task to begin and the date you want the task to be completed. You 
can select the same date in both boxes.

3 Type a subject.

4 (Optional) Type a priority for the task.

The task priority can consist of a character followed by a number. The following are acceptable 
formats: A1, C1, B, 3, and so forth.

5 Type a message.

6 Click Post on the toolbar.

Posted tasks are placed in your Calendar. They are not placed in your Mailbox, or in any other user's 
Mailbox.

TIP: You can also create a checklist that is not associated with your Calendar. In this type of 
checklist, any item type (mail, appointment, task, reminder note, phone message) can be used. For 
information, see Section 3.5.5, "Creating a Checklist,# on page 54.

4.2.3  Marking Tasks Completed

When you finish a task, you can mark it Completed. Tasks you mark Completed are not carried over 
to the next day on your Calendar. Completed tasks are distinguished by a check mark in your 
Calendar. Overdue tasks display in red.

If you mark a task Completed, then realize you left some part of it incomplete, you can unmark it. 
Unmarked tasks display on the current day in your Calendar.

When you mark a task Completed, GroupWise sends notification to the originator of the task if he or 
she selected return notification in Send Options. A Completed status, including the date and time the 
task was marked Completed, is placed in the originator's Properties window.

Marking a Task Completed

1 Click the Calendar tab on the Nav Bar.

2 Select the check box next to the task.

To unmark a task that has been marked Completed, deselect the marked check box next to the 
task.

4.3  Sending Reminder Notes
Reminder notes are like mail messages except they are scheduled for a particular day and appear on 
the Calendar for that date. You can use reminder notes to show vacations, holidays, pay days, 
birthdays, and so forth.

This section contains the following topics:

! Section 4.3.1, "Scheduling a Reminder Note for Yourself,# on page 64

! Section 4.3.2, "Scheduling a Reminder Note for Other Users,# on page 64
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4.3.1  Scheduling a Reminder Note for Yourself

Posted reminder notes are placed in your Calendar on the date you specify. They are not placed in 
your Mailbox or in any other user's Mailbox.

1 Select New > Posted Note.

2 Select a date.

3 Type a subject and the reminder note.

4 Click Post on the toolbar.

To access the information later, open your Calendar and select the date the information appears on. 
Double-click the reminder note in the Reminder Notes List.

4.3.2  Scheduling a Reminder Note for Other Users

1 Click New > Note.

2 In the To field, type a username, then press Enter. Repeat for additional users. If necessary, type 
usernames in the CC and BC fields.

or

To select usernames from a list, click Address on the toolbar, select each user!s name, double-
click each user, then click OK.

3 In the Start Date field, select the date this reminder note should appear in the recipients' 
Calendars.

You can specify many options, such as making this reminder note a high priority, requesting a 
reply from recipients, and more, by clicking the Send Options tab.

4 (Optional) Type a subject and the reminder note message.

5 Click Send on the toolbar.

4.4  Accepting or Declining Scheduled Items
When you receive an appointment, task, or reminder note, you might not be able to accept. In 
GroupWise, you can let the sender know if you accept or decline, specify a level of acceptance or 
availability, and add additional comments. You can also delegate the item to another user. The 
sender can find your response by checking the item's Properties.

1 Open the appointment, task, or reminder note.

2 Click Accept or Decline on the toolbar.

3 (Optional) You can type a comment, then click Decline or Cancel.

By default, the sender can view your comment by viewing the item properties in the Sent Items 
folder.
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4.5  Accepting or Declining Internet Items
You can accept or decline appointments, all day events, and tasks that are sent from Internet-enabled 
collaboration clients. Some of these clients include Microsoft* Exchange, Lotus Notes*, and 
Macintosh* iCal. 

1 Open the appointment, task, or reminder note.

2 Click Accept or Decline on the toolbar.

3 (Optional) You can type a comment, then click Decline or Cancel.

By default, a message is sent back to the sender of the item, indicating the action you took. 
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5Using Your Calendar

GroupWise® WebAccess lets you use advanced features to help you read and send messages, use the 
WebAccess calendar, organize messages in folders, print messages, use Proxy to access other 
mailboxes, and more.

You can view your schedule in a variety of views or formats, including day, week, month, year, task 
list, project planner, and multi-user.

This section contains the following topics:

! Section 5.1, "Using the WebAccess Calendar,# on page67

! Section 5.2, "Reading an Item in Your Calendar,# on page 70

! Section 5.3, "Scheduling an Appointment,# on page 70

! Section 5.4, "Assigning a Task,# on page 72

! Section 5.5, "Accepting an Appointment, Note, or Task,# on page 73

! Section 5.6, "Declining an Appointment, Note, or Task,# on page 74

! Section 5.7, "Delegating an Appointment, Note, or Task,# on page 74

! Section 5.8, "Saving an Item in Your Calendar,# on page 75

5.1  Using the WebAccess Calendar
The Calendar lets you view appointments, tasks, or notes you receive from others or created for 
yourself. You can view one day, one week, or one month at a time.

You open the Calendar from the toolbar, the Nav Bar, or from the Calendar folder in the GroupWise 
WebAccess main window.

The Calendar displays any appointments, tasks, and notes you received whether you have accepted 
them or not. You can perform the same actions on an item in the Calendar that you can on an item in 
the Mailbox, such as accepting, declining, delegating, or moving the item. In addition, you can also 
decline, delegate, or move items you have accepted that no longer appear in your Mailbox. While 
you have the Calendar open, you can also schedule appointments, assign tasks, post items, and write 
notes to other users.

You open the Calendar from the toolbar in the GroupWise WebAccess main window. When you 
open the Calendar, the HTML version is displayed.

If you need to set up the times you are available for appointments, your workschedule, use the 
GroupWise Windows client to set your workschedule. Then you can use the WebAccess client to 
correctly display your workschedule.

The calendar folder in the Nav Bar has a toolbar that provides access to several Calendar view 
options. You can view the Calendar in various formats, including day, week, and month.

! Section 5.1.1, "Using the Day View Calendar,# on page 68

! Section 5.1.2, "Using the Week View Calendar,# on page 68

! Section 5.1.3, "Using the Month View Calendar,# on page 69
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5.1.1  Using the Day View Calendar

1 Click the Calendar tab in the main window.

2 Click Day in the top right corner of the Calendar view.

The Day View calendar displays the current date. To change dates within the current month, 
click the desired date in the monthly calendar.

To move forward or backward one month, click the arrow buttons next to the month header in 
the monthly calendar. 

To return to the current day!s calendar, click Today. 

You can also click the drop-down by Today to select a calendar for a different date.

5.1.2  Using the Week View Calendar

1 Click the Calendar tab in the main window.
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2 Click Week in the top right corner of the Calendar view.

The Week View calendar displays the current week!s calendar. To change the view to display 
another week!s calendar, click any date from the desired week in the monthly calendar.

To move forward or backward one month, click the arrow buttons next to the month header in 
the monthly calendar.

To view the current date!s Day View calendar, click Today.

5.1.3  Using the Month View Calendar

1 Click the Calendar tab in the main window.
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2 Click Month in the top right corner of the Calendar view.

The Month View calendar displays the current month!s calendar. To change the view to display 
another month!s calendar, click the month in the yearly calendar.

To move forward or backward one month, click the arrow buttons next to the year header in the 
yearly calendar.

To view the current date!s Day View calendar, click Today.

5.2  Reading an Item in Your Calendar
1 Click the Calendar tab.

2 Click the item you want to read.

5.3  Scheduling an Appointment
1 In the GroupWise WebAccess main window, click New > Appointment to display an 

appointment dialog box.

or
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In the Calendar, right-click a day and select New Appointment.

2 Click Address Book to add recipients in the To, CC, and BC fields. If you want to create a 
personal appointment that displays only in your own Calendar, send the message to yourself, or 
create a posted appointment.

or

Type a recipient!s address in the To, CC, or BC field. The address can be a GroupWise user ID, 
GroupWise full name, or external e-mail address. Separate each address with a comma.

To schedule a resource, such as a conference room, that is available in the address book, add the 
resource to the To field. 

3 Type a location for the meeting.

If you added a resource to the To field, the location might be filled in automatically.

4 Specify the month, day, year, and beginning time for the appointment, then skip to Step 5.

or

Click Busy Search to find and insert an appointment time when all the recipients are available.

When you use Busy Search, GroupWise lists times when the users whose schedules were 
checked are available for an appointment. The time blocks listed might be longer than the 
duration specified. For example, 8am through 1pm might be listed as an available time. If your 
meeting has a duration of two hours, you could select from a number of available times, 
including 8am-10am, 9am-11am, and 11am- 1pm.

To schedule the appointment for one of the times listed, click the time, then skip to Step 6.

5 To set the duration, type a number, then select Hours, Minutes, or Days. 

You can use whole numbers or decimal numbers, such as 90 minutes or 1.5 hours.

6 Specify how you want the appointment to appear as. Appointments can appear as Free, 
Tentative, Busy, or Out of the Office.

7 Type a subject and message.

You can include Web site locations or addresses (URLs) in both the Subject and Message fields.
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8 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.

9 (Optional) Click Attach to attach files to the appointment. For this feature to work, your 
browser must support attachments.

10 (Optional) Click Send Options to select a security setting (classification), assign a priority 
(high, standard, low), request a reply, or select to receive return notification.

11 Click Send or click Post.

5.4  Assigning a Task
1 In the GroupWise WebAccess main window, click New > Task.

or

In the HTML Calendar, click New > Task.

or

In the Calendar, right-click a day and select New Task.

2 Click Address Book to add recipients in the To, CC, and BC fields. 

or

Type a recipient!s address in the To, CC, or BC field. The address can be a GroupWise user ID, 
GroupWise full name, or external e-mail address. Separate each address with a comma.

To create a personal task that displays only in your Calendar, add only your name or switch to 
posted task.

3 For the start date, specify the month, day, and year you want the task to first appear on the 
recipient!s Calendar.

4 Type a priority. 
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You can type a letter (such as A), a number (such as 1), or a letter-number combination with the 
letter first (such as A1).

5 For the due date, specify the month, day, and year when you want the task to be completed.

6 Type a subject and message.

You can include Web site locations or addresses (URLs) in both the Subject and Message fields.

7 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.

8 (Optional) Click Attach to attach files to the message. For this feature to work, your browser 
must support attachments.

9 (Optional) Click Send Options to select a security setting (classification), assign a priority 
(high, standard, low), request a reply, or select to receive return notification.

10 Click Send or click Post.

5.5  Accepting an Appointment, Note, or Task
1 Click the Mailbox in the Folder List.

or

Click the Calendar icon in the Folder List or on the Calendar Nav Bar, then go to the date of the 
appointment, task, or note.

2 Click the appointment, task, or note to open it, then click Accept.

The appointment, task, or note is removed from the Item List in your Mailbox and appears in 
your Calendar only. The sender can tell you accepted the item by checking its status 
information. 
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5.6  Declining an Appointment, Note, or Task
1 Click the Mailbox icon in the Folder List.

or

If you have already accepted the appointment, task, or note, click the Calendar icon in the 
Folder List or on the Calendar Nav Bar to open the Calendar, then go to the date of the 
appointment, task, or note.

2 Click the appointment, task, or note to open it.

3 Click Decline.

or

Right-click the item and click Decline.

4 (Optional) Type a message in the Comments to Sender field.

5 Click Decline.

The appointment, task, or note is removed from your Calendar and Mailbox. The status of the 
item is updated in the sender!s Mailbox to show that you have declined the item. If you 
commented when you declined the item, the sender can read your comments by checking the 
status information.

5.7  Delegating an Appointment, Note, or Task
1 Click the Mailbox icon in the Folder List.

or

If you have already accepted the appointment, task, or note, click the Calendar icon in the 
Folder List or on the Calendar Nav Bar to open the Calendar, then go to the date of the 
appointment, task, or note.

2 Click the appointment, task, or note to open it.

3 Click Delegate to open a Delegate form.

or

Right-click an item > click Delegate.

4 Click Address Book to add recipients in the To field.

or

Type a recipient!s address in the To field. The address can be a GroupWise user ID, GroupWise 
full name, or external e-mail address. Separate each address with a comma.

5 Type a message.

You can include Web site locations or addresses (URLs) in the Message field.

6 (Optional) Click Spell Check to spell check the message. For this feature to work, your browser 
must be enabled for Java.

7 (Optional) Click Attach to attach files to the appointment, task, or note. For this feature to 
work, your browser must support attachments.

8 Click Send.
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The original sender can see that you delegated the appointment, task, or note by checking the 
status information for the item. You can also see whether the delegated item was accepted or 
declined by opening your Sent Items folder and checking the status information for the 
delegated item. 

5.8  Saving an Item in Your Calendar 
1 In your Mailbox or Calendar, open the item you want to save, then click File > Save As.

2 Select the location in which to save the item.

3 Type a filename for the item in the Name field.

4 To save the item in a different directory than is shown in the Save in folder field, click Browse, 
then select the new directory.

5 Click Save, then click Close.

Saved items remain in your Calendar as well as being copied to the location you specify. Items are 
saved in HTML format with a .html extension so that they can also be opened in your Web browser. 
Attachments are saved in their original format.
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6Using the Address Book

The Address Book stores information about users, resources, and organizations. You can use the 
Address Book to search for information or to add e-mail addresses to an item you are composing.

The Address Book consists of the GroupWise system address book, one or more personal address 
books, the Frequent Contacts address book, and possibly shared address books and LDAP address 
books.

! GroupWise System Address Book: You have one GroupWise system address book. The 
system address book includes all users who have a GroupWise Mailbox in your organization. 
You cannot modify the system address book. Use this address book to view information about 
everyone in your GroupWise system, select names to send an item to, and create and modify 
groups.

! Personal Address Books: You can have multiple personal address books. By default, 
GroupWise WebAccess provides one predefined personal address book with your name as the 
title. You can use your personal address book to add e-mail addresses and information for users, 
resources, or organizations that are not defined in the system address book. When you create 
multiple address books, you can include the same name and address in several books. If the 
entry is copied from an address book and you edit the entry!s information in one book, it is 
updated in all books.

! Frequent Contacts Address Book: You have one Frequent Contacts address book. Your most 
frequently and most recently used addresses are automatically added to this book. Any 
recipients of items sent in the WebAccess client are added to the Frequent Contacts address 
book. In addition, addresses added by the Windows GroupWise client also appear in the 
GroupWise WebAccess Frequent Contacts address book. After an entry is placed in Frequent 
Contacts, it remains there until you delete it. The entry also remains in its original address 
book. Although the Frequent Contacts address book is created by GroupWise, it is considered a 
personal address book because you can edit the information for contacts. 

! Shared Address Books: In the Windows version of the GroupWise client, users can share 
address books with other users. In GroupWise WebAccess, you cannot share an address book 
with other users, but you can receive shared address books. When you accept a shared address 
book, it appears in your Address Book list along with your system address book, personal 
address book, and Frequent Contacts address book.

This section contains the following topics:

! Section 6.1, "Searching for Users and Resources,# on page 78

! Section 6.2, "Using Groups to Address Items,# on page 81

! Section 6.3, "Using the Address Selector,# on page 84

! Section 6.4, "Using Frequent Contacts,# on page 85

! Section 6.5, "Using Personal Address Books,# on page85
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6.1  Searching for Users and Resources
To open the GroupWise® Address Book, click the Address Book button  on the Main 
Window toolbar. The Address Book opens, displaying a drop-down menu that lists the system 
address book, Frequent Contacts address book, and any personal address books you have created. 

You can use the drop-down menu to select the address books in this view. The bottom pane lists the 
matching search entries in the selected address book.

You can also specify search criteria by using the predefined filters. For example, you can use the 
begins with filter to display only entries with last names that begin with "D.#

When you begin typing a name in the To, CC, or BC fields of an item you are creating, Name 
Completion tries to complete the name for you.

If Name Completion finds the name you are looking for, you can stop typing. If Name Completion 
doesn't find it, continue typing. Name Completion searches again after each new character you type. 

This section contains the following topics:

! Section 6.1.1, "Viewing People, Resources, or Groups in the Address Book,# on page 78

! Section 6.1.2, "Searching for an Entry in the Address Book,# on page 79

! Section 6.1.3, "Using Filters to Narrow an Address Search,# on page 80

! Section 6.1.4, "Addressing an Item,# on page 80

6.1.1  Viewing People, Resources, or Groups in the Addr ess 
Book

Use the predefined filters in the View menu to display only groups, users, organizations, or 
resources in an address book.

The Address Book uses the following icons to identify people, resources, and groups in address 
books:

 People

 Resources

 Groups

Address books display all entries by default. Although all groups, companies, and resources are 
marked by icons, finding specific entries in large address books can prove difficult. A predefined 
filter displays only the type of entry you are looking for.

To view groups, organizations, or resources in an address book,

1 In the Main Window, click  on the toolbar.

2 Select an address book.

3 Click  to filter for contacts, groups, and resources.

4 Select the Entry Type and Number of names to display.

5 To return to the non-filtered address book view, click  again.
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In the Address Selector, click a predefined filter from the  drop-down list to filter for people, 
groups, and resources.

6.1.2  Searching for an Entry in the Address Book

1 In the Main Window, click  on the toolbar.

or

Click  on the toolbar in an item you are composing.

2 In the Address Books list, select the address book you want to search.

For GroupWise, you can choose from the GroupWise address book, the Frequent Contacts 
address book, or a personal address book.

3 Select the number of entries you want displayed at one time. The default displays 15 entries at 
one time.

4 To list the first entries in the selected address book, leave the search conditions boxes empty.

or

To search for a specific entry, click the  icon to show another set of search condition boxes 
and the  icon to hide all search conditions boxes. These boxes let you define the Address 
Book fields and information you want to search.

GroupWise WebAccess supports the * (asterisk) and ? (question mark) wildcards. When 
searching a field, you can use * to represent multiple characters and ? to represent one 
character. If you define a "Last Name contains s?n# condition, the search returns all entries 
whose last names contain S and N separated by one character (Sanders, Johannson, Larsen, and 
so forth).

5 Click Search Address Book (or Search) to display a list of entries that match your search 
conditions.
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If you decide to send an item to a user you found, you can select a user, click To, CC, or BC to 
add the name to the recipient list, then click Mail to open a new item. 

NOTE: Double-clicking a user adds it to the To list.

6.1.3  Using Filters to Narrow an Address Search

1 In the Main Window, click  on the toolbar.

or

Click  on the toolbar in an item you are composing.

2 Select the address book you want to search.

3 Select whether you want to search for the name, last name, first name, or department.

4 Select which predefined filter you want to use: begins with, equals, does not begin with, or not 
equal.

For example, to list only users whose last name is Davis, select Last Name, select equal to, then 
type "Davis.#

5 Type the information you want to search for.

Name Completion completes the name.

To filter the list of entries by contacts, groups, or resources, click an option on the  drop-
down list.

You can click  to add additional search parameters.

6 Click Search.

6.1.4  Addressing an Item

1 Open a new item.

2 Click Address Book to open the Address Book.

By default, the Address Book opens to the GroupWise address books.

3 In the Address Books list, select the address book you want to search.

For GroupWise, you can choose from the GroupWise address book, the Frequent Contacts 
address book, or a personal address book.

4 Select the number of entries you want displayed at one time. The default displays 15 entries at 
one time.

5 To list the first entries in the selected address book, leave the search conditions boxes empty.

or

To search for a specific entry, use the search conditions boxes to define the Address Book fields 
and information you want to search.

GroupWise WebAccess supports the * (asterisk) and ? (question mark) wildcards. When 
searching a field, you can use * to represent multiple characters and ? to represent one 
character. For example, if you define a "First Name begins with jo*# condition, the search 
returns all entries whose first names start with JO (John, Joel, Jose, and so forth). If you define 
a "Last Name contains s?n# condition, the search returns all entries whose last names contain S 
and N separated by one character (Sanders, Johannson, Larsen, and so forth).
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6 Click Search to display a list of entries that match your search conditions.

7 Select the entry you want to add to the item!s recipient list, then click To, CC, or BC to indicate 
the recipient type.

NOTE: You can double-click the name to add it to the To: list.

8 After you finish selecting the item!s recipients, click OK to add them to the item.

6.2  Using Groups to Address Items
A group is a list of users or resources you can send messages to. Use groups to send a message to 
several users or resources by typing the group name in the To, BC, or CC fields. There are two types 
of groups: public and personal.

A public group is a list of users created by the system administrator, and it is available for use by 
each GroupWise user. For example, there might be a public group for the Accounting Department. 
Each employee in Accounting is included in the group. Public groups are listed in the system 
address book.

A personal group is a group created by you. For example, if you often send an appointment to your 
work group, you can include each co-worker's address or name and a meeting place (a resource) in a 
personal group.

This section contains the following topics:

! Section 6.2.1, "Creating a Personal Group,# on page 81

! Section 6.2.2, "Addressing Items to a Group,# on page 83

! Section 6.2.3, "Adding and Removing Contacts from a Personal Group,# on page 83

! Section 6.2.4, "Viewing Group Information,# on page 83

! Section 6.2.5, "Deleting a Group from a Personal Address Book,# on page 84

6.2.1  Creating a Personal Group

1 In the Main Window, click  on the toolbar.

By default, the Address Book opens to the GroupWise address books. 

2 In the Address Books list, select the address book that contains the entries you want to add to 
the group.

For GroupWise, you can choose from the GroupWise address book, the Frequent Contacts 
address book, or a personal address book.

3 Select the number of entries you want displayed at one time. The default displays 15 entries at 
one time.

4 To list the first entries (15 by default) in the selected address book, leave the search conditions 
boxes empty.

or

To search for a specific entry, click the  icon to show another set of search condition boxes 
and the  icon to hide all search conditions boxes. These boxes let you define the Address 
Book fields and information you want to search.
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GroupWise WebAccess supports the * (asterisk) and ? (question mark) wildcards. When 
searching a field, you can use * to represent multiple characters and ? to represent one 
character. For example, if you define a "First Name begins with jo*# condition, the search 
returns all entries whose first names start with JO (John, Joel, Jose, and so forth). If you define 
a "Last Name contains s?n# condition, the search returns all entries whose last names contain S 
and N separated by one character (Sanders, Johannson, Larsen, and so forth).

5 Click Search to display a list of entries that match your search conditions.

6 Select the entry you want to add to the group, then click To, CC, or BC to indicate the recipient 
type. You can also double-click the user icon to add it to the To list.

If you are using the HTML Address Book, you can add multiple recipients at one time by 
selecting the check boxes in front of the recipients! entries.

7 After you select the entries you want to add to the group, click Save Group to display the Save 
Group dialog box.

8 In the Personal Address Books list, select the personal address book where you want to save the 
group.

9 Type a name and description (optional) for the group, then click Save.

The group is added to the personal address book. When addressing items, you can type the 
group name in the To, CC, or BC field, or you can use the Address Book to include it. The item 
is sent to each member of the group.

You can also create and save a personal group from the Address Selector when you are addressing a 
message or other item:

1 In an item view, click Address Book on the toolbar.

2 Search for each member of your group and add them to the right pane.

To filter the list of entries by contacts, groups, or resources, click an option on the  drop-
down list.

3 To add an entry that is not in an existing address book, click Add Entry, fill in the information, 
click OK, then select the entry.

4 Click Save Group.

or

If you want to save the group to a different address book than the one that is displayed, select 
the address book.

5 Type a name for the group.

6 Type comments, such as a description of the group.

7 Click OK.
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6.2.2  Addressing Items to a Group

1 In an item view, click  on the toolbar.

2 Select the personal address book you saved your group in.

3 Search for the name of your group.

For example, select Name begins with "Project# to find your Project Team group.

4 Select a group, then click To, CC, or BC.

5 Repeat as necessary.

6 To see more information about the group, click the group!s name.

7 Click OK to return to the item view.

6.2.3  Adding and Removing Contacts from a Personal Gro up

1 In the Main Window, click  on the toolbar.

or

Click  on the toolbar in an item you are composing.

2 Select the address book the group is saved in.

3 Search for the name of the group.

For example, select Name begins with "Project# to find the Project Team group.

4 Click the group!s name.

5 Click Modify, then click Close.

The right pane of your Address Book window is now populated with the members of your 
group.

6 To add a contact, search for the contact, select the contact from the search list, and click To: 
CC: or BC:.

Your contact is now added to the list of the group!s members.

7 To remove a contact, find the contact!s name in the right pane and click the red X next to the 
contact!s name.

That contact is removed from the list of the group!s members.

8 Repeat Steps 6 and Step 7 as necessary.

9 Click Save Group.

6.2.4  Viewing Group Information

1 In the Main Window, click  on the toolbar.

or

Click  on the toolbar in an item you are composing.

2 Select the address book your group is saved in. 

3 Search for the name of your group.

For example, select Name begins with "Project# to find your Project Team group.
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4 Click the group!s name.

A list of all group members is displayed.

6.2.5  Deleting a Group from a Personal Address Boo k

1 In the Main Window, click  on the toolbar.

2 Select the address book the group is saved in.

3 Search for the name of the group.

For example, select Name begins with "Project# to find your Project Team group.

4 Select the check box next to the group!s name.

5 Click Delete.

The group is deleted.

6.3  Using the Address Selector
When you are composing a new item and click the Address Book button on the item view toolbar, 
the Address Selector displays. The Address Selector presents a simplified view of the Address 
Book, providing you with the options you need to select a name or create a group. 

The Address Selector displays in other places throughout GroupWise, for example, when you are 
selecting recipients of a task, entries for a filter or find, and so forth. It might be slightly modified to 
show only context-appropriate options.

You can resize the Address Selector by dragging a corner of the window. 

You can open a contact entry to view details by clicking the contact!s name.

6.3.1  Accessing the Address Selector

1 In an item you are composing, click Address Book on the toolbar.

2 Select an address book from the Address Books drop-down list.

3 Click the drop-down list to select how you want to locate a recipient (by name, last name, or 
first name), then type the recipient's name.

To filter the list of entries by contacts, groups, or resources, click an option on the  drop-
down list.

If you know the person's name, begin typing it in the To field of the item view. Name 
Completion searches the Frequent Contacts address book, the current address book, and the 
system address book. When Name Completion finds the person you want to send a message to, 
you can stop typing.

4 Click the names you want as primary (To) recipients of your message.

5 To address carbon copy recipients, click CC, then click the names you want.

6 To address blind copy recipients, click BC, then click the names you want.

7 Click OK.
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6.3.2  Creating Contacts Using the Address Selector

To create a new contact, click Add Entry, enter the contact information in the different tabs, then 
click OK.

You can add contacts to the right pane and then create a group by clicking Save Group. If you click 
the down-arrow on the Address Books list, you can select which address book the group is saved to. 
Otherwise it is saved to the address book displayed in the Address Selector.

6.4  Using Frequent Contacts
Use the Frequent Contacts address book to access your most frequently used or most recently used 
entries. When you use an address in a message, the entry is copied to the Frequent Contacts address 
book. After an entry is placed in Frequent Contacts, it remains there until you delete it. The entry 
also remains in its original address book.

1 Click  in an item you are composing.

2 Select Frequent Contacts from the Address Book drop-down list.

3 Search for the names you want.

4 Click the names you want, then click OK.

The Frequent Contacts address book cannot be deleted, although individual entries can be removed 
from it.

6.5  Using Personal Address Books
You can have multiple personal address books. By default, GroupWise WebAccess provides one 
predefined personal address book with your name as the title. You can use your personal address 
book to add e-mail addresses and information for users, resources, or organizations not defined in 
the system address book. These addresses can be for people inside or outside of your organization.

When you create multiple address books, you can include the same name and address in several 
books. If the entry is copied from an address book and you edit the entry's information in one book, 
it is updated in all books.

You can add and delete names and address information for any contact (person, company, or 
resource) you want in your personal address books. You can also create your own information 
properties (fields).

Personal address books list addresses according to your preferences. For example, you can include 
Internet addresses or no address at all for the people you add to your personal address books. You 
can also create personal groups. If you save a list of people as a group, you only need to type the 
group name in the To box to send the entire group a message.

This section contains the following topics:

! Section 6.5.1, "Creating a Personal Address Book,# on page 86

! Section 6.5.2, "Deleting a Personal Address Book,# on page 86

! Section 6.5.3, "Editing a Personal Address Book,# on page 86

! Section 6.5.4, "Accepting a Shared Address Book,# on page 88
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6.5.1  Creating a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click Address Book Options.

3 Click Create to display the Create Address Book form.

4 In the Address Book Name field, type the name you want to use for the personal address book.

5 If desired, type a description in the Description field.

The description is for your use only. It appears only when viewing the address books in the 
Address Books Options form.

6 Click OK to add the new address book to the Personal Address Book list.

7 Click Close to return to the Address Book.

You can add and modify records in your personal address books. However, only the system 
administrator can add and modify records in the system address book.

6.5.2  Deleting a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click Address Book Options.

3 Click Delete next to the name of the personal address book you want to delete.

After it is deleted, a personal address book cannot be recovered.

6.5.3  Editing a Personal Address Book

In a personal address book, you can add or delete entries, edit existing information, copy names 
from one book to another, or rename a book. You can also create your own custom address book 
fields.

This section contains the following topics:

! "Adding Entries to a Personal Address Book# on page87

! "Deleting Entries from a Personal Address Book# on page 87

! "Editing Entries in a Personal Address Book# on page 87

! "Copying Entries Between Personal Address Books# on page 88

! "Renaming a Personal Address Book# on page 88
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! "Copying a Personal Address Book# on page 88

Adding Entries to a Personal Address Book

1 From the GroupWise WebAccess main window, click Address Book to open the Address Book. 

2 In the Address Book, click Add Entry to display the Add Address Book Entry form.

3 If you want to add a resource or organization rather than a person, click Resource or 
Organization.

4 Select the personal address book where you want to add the entry.

5 Fill in at least one of the fields that have an asterisk. This is required so that the entry can be 
listed in the Address Book.

If you want to send messages to the entry, make sure you complete the E-Mail Address field.

6 Fill in any other fields you want. Any information you add displays when you select the entry 
in the Address Book.

7 Click OK to save the entry to the selected address book. 

Deleting Entries from a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Select the address book, then search for the names you want to remove.

3 Check the box next to each name you want to remove.

4 Click Delete.

Editing Entries in a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Select the address book, then search for the name you want to edit.
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3 Click the name you want to edit.

4 Edit the information in the different fields, then click OK.

Copying Entries Between Personal Address Books

You cannot copy names to the system address book.

1 In the Main Window, click  on the toolbar.

2 Click an address book, then search for the names you want to copy.

3 Check the box next to each name you want to copy.

4 Click Copy.

5 Select the address book you want to copy the names to, then click OK.

Renaming a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click Address Book Options.

3 Click the name of the address book you want to rename.

NOTE: You cannot rename the Frequent Contacts address book.

4 Type the new name, then click OK.

Copying a Personal Address Book

1 In the Main Window, click  on the toolbar.

2 Click Address Book Options.

3 Click Save As next to the personal address book you want to copy.

4 Type a name for your address book, then click OK.

6.5.4  Accepting a Shared Address Book

In the Windows version of the GroupWise client, users can share address books with other users. In 
GroupWise WebAccess, you cannot share an address book with other users, but you can receive 
shared address books. When you accept a shared address book, it appears in your Address Book list 
along with your system address book, personal address book, and Frequent Contacts address book.

1 Click the Mailbox icon in the Folder List.

2 Click the shared address book notification to open it, or right-click it > click Open.

3 Click Accept Address Book to add the address book to the Address Book list.

You can now use the shared address book to address items or look up user information just as you 
would in other address books.
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89

7Customizing Your GroupWise 
WebAccess Client

You can adapt GroupWise WebAccess to your specific needs by changing how many messages 
display, your password, your send options, your time zone, and more.

This section contains the following topics:

! Section 7.1, "Specifying the Number of Messages to Display,# on page 89

! Section 7.2, "Changing Your GroupWise Password,# on page 89

! Section 7.3, "Using Rules,# on page 90

! Section 7.4, "Specifying Send Options,# on page 93

! Section 7.5, "Changing Your Time Zone,# on page 95

7.1  Specifying the Number of Messages to 
Display
You can choose the number of messages that display in each window.

1 In the GroupWise WebAccess main window, click Options in the right corner.

2 Select the General tab.

3 Use the drop-down menu to select the number of messages you want to display.

4 Click Save, then Close.

7.2  Changing Your GroupWise Password
If your system administrator has turned on LDAP authentication, your LDAP password is used 
instead of your GroupWise password when you access GroupWise WebAccess. If LDAP 
authentication is turned on, the following procedure changes your LDAP password:

1 In the GroupWise WebAccess main window, click Options in the right corner.
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2 Click the Password tab.

3 Type your old password.

4 Type your new password, then retype the new password to confirm it.

Remember that your password is case sensitive.

5 Click OK.

IMPORTANT: When you change your password in GroupWise WebAccess, you change it for 
your GroupWise Mailbox. That means that you always use the same password to log in to your 
GroupWise Mailbox whether you are using GroupWise WebAccess or another version of the 
GroupWise client.

7.3  Using Rules
You can use rules to define actions that you want to be performed on items you receive. For 
example, you can forward or reply to messages or move messages to folders. Rules can help you 
organize your Mailbox, automate your Mailbox while you are away, or delete unwanted items.

Rules are stored in your GroupWise Mailbox at your post office. Because of this, rules you define in 
other versions of the GroupWise client also appear in the Rules list and apply when you use 
GroupWise WebAccess.

You can edit any rules you create in GroupWise WebAccess. If you create rules using another 
version of the GroupWise client, you can edit those rules provided they do not contain more 
capabilities than GroupWise WebAccess allows you to set. For example, the Windows version of the 
GroupWise client lets you create rules to apply to items you are sending. Because the Rules feature 
in GroupWise WebAccess does not include this capability, you cannot edit that rule.

This section contains the following topics:

! Section 7.3.1, "Creating a Rule,# on page 91

! Section 7.3.2, "Activating or Deactivating Rules,# on page 92

! Section 7.3.3, "Forwarding Your E-mail to Another Account,# on page 93
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7.3.1  Creating a Rule

When you create a rule, you must do the following:

! Select the type of action you want performed. 

! Name the rule. By naming the rules, you can have more than one rule that uses the same action. 

! Define any optional conditions. For example, you might want to move all items from your 
supervisor to a specific folder. You can define a condition so that only messages with your 
supervisor!s name on the From line are moved to the folder. All other items remain in your 
main Mailbox folder. 

! Fill in the information required to carry out the action. For example, you might need to specify 
the folder where you want to move the messages. 

! Save the rule. 

1 From the GroupWise WebAccess main window, click the Options icon.

2 Click Rules.

3 Select the type of rule you want to create:

! Delete: Moves an item to the Trash. You can apply the rule to all new items or only new 
items that meet the criteria you establish. 

! Forward: Forwards an item to the recipients you specify. You can apply the rule to all 
new items or only new items that meet the criteria you establish.

! Move to Folder: Moves an item to the folder you specify. You can apply the rule to all 
new items or to only new items that meet the criteria you establish.

! Reply: Generates a reply to an item. The reply can go to the sender of the item only 
(Reply to Sender) or to all recipients of the item (Reply to All). You can apply the rule to 
all new items or only new items that meet the criteria you establish.

! Vacation: Generates a reply to all new items you receive. The reply goes to the sender of 
the item only (Reply to Sender), not to all recipients of the item (Reply to All). 

4 Click Create to display the Create Rule form.

5 Type the name you want to use for the rule. Names can include any characters, including 
spaces.

6 If desired, define an optional condition to limit the items that are affected by the rule. If you do 
not define an optional condition, the rule is applied to all new items you receive.
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You cannot define an optional condition for the Vacation rule. The Vacation rule is applied to 
all items.

7 Define the actions that you want performed when the rule is applied. 

The actions vary depending on the type of rule you are creating. For example, when creating a 
rule to reply to items, you select whether you want to reply to the sender only or the sender and 
all recipients. When moving an item to a folder, you select the destination folder.

If you want to create a rule to forward items to another account, specify the e-mail address. 

8 Click Save to save the rule to the Rules list.

9 By default, the rule is automatically activated. If you don!t want the rule to be active at this 
time, deselect the rule!s Activate box, then click Save.

or

To keep the rule active, click Close. 

When you create a rule, GroupWise WebAccess stores it in your GroupWise Mailbox at your post 
office. Whether you log in to your Mailbox through GroupWise WebAccess or another version of 
the GroupWise client, you always have the same rules.

7.3.2  Activating or Deactivating Rules

By default, when you save a rule that you have just created, it is automatically activated. GroupWise 
WebAccess executes the rule for any new items you receive. It does not execute the rule for any 
items you have already received.

1 From the GroupWise WebAccess main window, click the Options icon.

2 Click Rules.

3 In the list of active rules, click the rule!s check box to activate it or deactivate it.

A check mark indicates that the rule is active.

4 Click Save to save the changes.
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7.3.3  Forwarding Your E-mail to Another Account

Use the following procedure to create a rule that automatically forwards new items entering your 
mailbox to a different e-mail account.

1 From the Create Rule form, select the Forward rule, then click the Create button.

2 Type a name for the rule in the Rule name field.

3 In the first condition field, select To. This tells the rule to check the To: line in each incoming 
item.

4 In the second condition field, select Matches. This tells the rule that the text in the incoming 
item!s To: line must match the text you type in the next condition field. 

5 In the last condition field, type the complete e-mail address of the account from which you 
want to move the e-item. For example: msmith@corporate.com.

6 Define the actions to be taken by the rule. In the first action field, type the complete e-mail 
address of the account to which you want to send the item. Include other addresses to which 
you might want to courtesy copy or blind copy.

7 Type a subject to the e-mail indicating that it is moving from the old account to the new. For 
example: From msmith@corporate.com to marys@corporate.com.

8 Use the message field to include any other notes or instructions for the reader at the new 
account.

9 Click the Save button.

7.4  Specifying Send Options
You can specify send options for different types of items (mail, appointment, task, note, phone 
message) you send, and you can specify global send options that affect every item you send. Send 
options include the following:

! Section 7.4.1, "Changing the Security Setting (Classification) of All Items You Send,# on 
page 93

! Section 7.4.2, "Changing the Priority of All Items You Send,# on page 94

! Section 7.4.3, "Requesting a Reply for All Items You Send,# on page 94

! Section 7.4.4, "Getting a Return Receipt for All Items You Send,# on page 95

7.4.1  Changing the Security Setting (Classificatio n) of All Items 
You Send

A classification is a security setting that lets the recipient know if the item is confidential, top secret, 
and so forth. This information appears at the top of the item. A classification does not provide any 
encryption or additional security. It is meant to alert the recipient to the relative sensitivity of the 
item.

1 In the GroupWise WebAccess main window, click the Options icon.
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2 Click Send Options.

3 Select a security setting from the Classification drop-down list.

4 Click Save, then click Close.

7.4.2  Changing the Priority of All Items You Send

Recipients can see the priority of an item by looking at the color of the icon next to the item in the 
Item List. High priority items are red, normal priority items are white, and low priority items are 
gray.

1 In the GroupWise WebAccess main window, click the Options icon.

2 Click Send Options.

3 Select a priority.

The small icon next to an item in the Mailbox is red when the priority is high, white when the 
priority is standard, and gray when the priority is low.

4 Click Save, then click Close.

7.4.3  Requesting a Reply for All Items You Send

When you request a reply to an item, the recipient of the item sees an icon next to the item in the 
Item List. If you select When Convenient, "Reply Requested: When convenient# appears at the top 
of the item. If you select Within x Days, "Reply Requested: By xx/xx/xx# appears at the top of the 
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item. If the recipient attempts to delete an item without replying, he or she is reminded that the item 
requested a reply. (The recipient can still delete the item without replying.)

1 In the GroupWise WebAccess main window, click the Options icon.

2 Click Send Options.

3 Under Reply Requested, specify when you want to receive a reply.

The recipient sees  next to the message. If you select When Convenient, "Reply Requested: 
When convenient# appears at the top of the message. If you select Within x Days, "Reply 
Requested: By xx/xx/xx# appears at the top of the message.

4 Click Save, then click Close.

7.4.4  Getting a Return Receipt for All Items You S end

Return notification lets you know information such as when the recipient opens or deletes an item, 
declines an appointment, or completes a task.

1 In the GroupWise WebAccess main window, click the Options icon.

2 Click Send Options.

3 In the Return Notification group box, specify the type of return receipt you want.

If you select to receive Notify, this applies only when you are using the GroupWise client for 
Windows. Receiving notifications through Notify is not supported in GroupWise WebAccess.

4 Click Save, then click Close.

7.5  Changing Your Time Zone
To ensure that dates and times are correct in messages, appointments, and other time-relevant 
information, GroupWise WebAccess must know the time zone in which you are located. GroupWise 
WebAccess automatically adjusts the time for appointments sent between people in different time 
zones. For example, if you are located in New York and schedule a conference call with people in 
Los Angeles for 4:00 p.m. your time, the appointment received by the Los Angeles recipients will 
show the conference call at 1:00 p.m. their time.

By default, GroupWise WebAccess uses the time zone established for your GroupWise post office. 
However, if you are using GroupWise WebAccess in a time zone other than your post office!s time 
zone, you should change your time zone setting. For example, if your post office is located in New 
York but you are working in Chicago, you would need to change your time zone setting from 
Eastern Time to Central Time.

The GroupWise WebAccess time zone setting applies only to GroupWise WebAccess. If you have 
access to the Windows version of the GroupWise client, that client will use the time zone configured 
through the Windows operating system, not the time zone you set in GroupWise WebAccess.

1 In the GroupWise WebAccess main window, click the Options icon.
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2 Click Time Zone.

3 Select the time zone you want your GroupWise WebAccess messages and appointments based 
on.

4 Click Save.
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8GroupWise Frequently Asked 
Questions

The GroupWise 7 Client Frequently Asked Questions (FAQ) is intended to help GroupWise client 
users who have not found the information they need in the GroupWise client online help or User 
Guides.

This section contains the following information:

! "How Do I Find What I Need in the GroupWise Client Documentation?#

! "GroupWise Windows Client FAQ#

! "GroupWise Cross-Platform Client FAQ#

! "GroupWise WebAccess Client FAQ#

! "Non-GroupWise Clients FAQ#

! "GroupWise Client Comparison#

! "Where Do I Go for More Help?#
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ADocumentation Updates

This section lists updates to the GroupWise 7 WebAccess Client User Guide that have been made 
since the initial release of GroupWise® 7. The information helps you to keep current on 
documentation updates and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the GroupWise 7 Windows WebAccess User 
Guide was republished, and includes the following dates:

! Section A.1, "April 16, 2007,# on page 99

! Section A.2, "February 26, 2007,# on page 99

! Section A.3, "September 29, 2006,# on page 100

! Section A.4, "May 31, 2006,# on page 100

! Section A.5, "November 30, 2005,# on page 100

A.1  April 16, 2007

Table A-1   April 16, 2007 Updates

A.2  February 26, 2007

Table A-2   February 26, 2007 Updates

Location Update

Section 2.1, "Composing Items,# on 
page 19

Added a paragraph about the WebAccess client using the 
default browser text size.

Section 1.3.3, "Folder List,# on 
page 14

Added a comment that system folders cannot be renamed.

Section 2.5.4, "Moving an Item to a 
Folder,# on page 30

Added a note about not being able to view archived items using 
the WebAccess client.

Section 5.1, "Using the WebAccess 
Calendar,# on page 67

Added a note about using the GroupWise Windows client to set 
up your workschedule and then use the WebAccess client to 
correctly display and view your workschedule.

Section 4.1, "Scheduling 
Appointments,# on page 57

Updated two screen shots.

Location Update

Section 2.5, "Using the Folder List,# on 
page 28

Changed references to an arrow located next to Cabinet folders 
to be references to a plus sign (+).

Section 3.5, "Managing Received 
Items,# on page 52

Updated the Mailbox View screen shot.
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A.3  September 29, 2006
Rewrote entire document.

A.4  May 31, 2006

Table A-3   May 31, 2006 Updates

A.5  November 30, 2005

Table A-4   November 30, 2005 Updates

Section 5.1.1, "Using the Day View 
Calendar,# on page 68

Updated the instructions on selecting a different date to view in a 
user!s Calendar.

Section 3.2.3, "Adding A Signature to 
Items You Send,# on page 46

Removed a paragraph about signatures being the same for all 
GroupWise clients. This functionality is being investigated to 
include in a future release.

Location Update

Section 2.3.3, "Resending Items,# on page 28 Added a section on how to resend an item.

Chapter 6, "Using the Address Book,# on page 77 Added additional information about recipients being 
automatically added to the Frequent Contacts 
address book.

Section 3.2.3, "Adding A Signature to Items You 
Send,# on page 46

Added additional information on how to be 
prompted for your signature.

Location Update

"About This Guide# on page 9 Transitioned to revised Novell® documentation 
standards. Along with a new look, you might find 
different documentation file sizes.

Section 6.2.3, "Adding and Removing Contacts 
from a Personal Group,# on page 83

Added a section on how to edit a personal group.

Section 7.3.3, "Forwarding Your E-mail to Another 
Account,# on page 93

Added a section on how to forward all e-mail to a 
personal account.

Location Update


